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[bookmark: alternative-chapters][bookmark: _Toc165644510]Alternative chapters
So far, we’ve mainly been using raster data for analysis. Where we’ve had vector data we’ve often converted it to raster to carry out the analysis, then sometimes back to vector for display.
In this chapter we’ll look more closely at using vector data for analysis.
This is an optional chapter which follows on from the chapter on downloading English and Welsh census data and adding it to GIS. This chapter covers how to analyse and display vector data to answer research questions with GIS.
Note that this chapter is optional. You can choose between working through this one, or the chapter on Environmental Decision Making.
Both chapters contain techniques that past students have gone on to use in their dissertations.
The decision making chapter is mainly raster-based again, and covers combining a series of layers for complex analysis using physical geography examples.
If you are more interested in human geography-type applications of GIS you may find this vector analysis chapter more useful.
Of course, you are welcome to work both chapters if you wish.
[bookmark: learning-outcomes-for-vector-analysis][bookmark: _Toc165644511]Learning outcomes for vector analysis
When you have completed this section of the workbook you should be able to
· Demonstrate how to analyse and display vector data in a variety of ways to answer research questions with GIS.
[bookmark: introduction][bookmark: _Toc165644512]Introduction
In this chapter we will use vector boundary layers and vector point data in various ways to explore the distribution of reported crimes in Leeds from a single month.
These methods should give you an idea of what is possible with vector data and how you can display it. Try out the suggestions, then investigate some more of the tools in the vector processing toolboxes in QGIS to see what else is possible.
[bookmark: Xb42b2cd627511cdff768c66bc450c5b66190ee4][bookmark: _Toc165644513]Downloading data for vector data analysis
The data for this chapter can all be downloaded from the web. Much of it is freely available under the Open Government licence.
[bookmark: X8ec4ff87475d1f6069493648f2cf19d51f78b1f]Census boundary data for Middle Layer Super Output Areas
We are going to use slightly larger census areas than we did in the census chapter, otherwise the data could get too fine-grained as Output Areas tend to be very small. This time we will use Middle Layer Super Output Areas, or MSOAs, covering the Local Authority District for Leeds.
For more information about MSOAs it’s worth having a look at Alastair Rae’s article, Hey, what’s an MSOA?.
[bookmark: browsing-for-boundary-data]Browsing for boundary data
For these exercises we’ll download boundary data from the Office for National Statistics (ONS) as we did in the Census data chapter.
· Go to the Office for National Statistics Open Geography Portal.
· On the menu at the top of the page click on Boundaries
· Go to Census Boundaries then to Middle Layer Super Output Areas
· Click on the link to 2021 Boundaries as we’ll be using 2021 census data.
· Look for the link to Middle layer Super Output Areas (December 2021) Boundaries EW BFE V7 (the name and version number may vary slightly. BFE indicates full extent data) and click on it.
· The page that opens gives you a preview of the data on a map and a description of the data. Have a look at the page.
· Now click on Download and choose to download GeoPackage. Save the downloaded .gpkg file to your GIS project folder.
[bookmark: local-authority-districts]Local Authority Districts
You’ll also need a layer for Local Authority Districts. These are much larger administrative units and will give you a boundary for the whole of Leeds.
· Go back to the Office for National Statistics Open Geography Portal home page.
· On the menu at the top of the page click on Boundaries
· Go to Administrative Boundaries then to Local Authority Districts
· It makes sense to keep the boundary data consistent, so click on the link for 2021 Boundaries.
· Look for the Feature Layer for Local Authority Districts (December 2021) GB BFE and download the GeoPackage in the way that you downloaded the MSOAs.
[bookmark: preparing-the-boundary-data]Preparing the boundary data
The data you’ve downloaded covers the whole of England and Wales (or Great Britain in the case of the Local Authority Districts). We will be working with data covering only within the Leeds Local Authority so it makes sense to restrict all our layers to that area. As usual it saves processing time and computer space.
· Add the Local Authority Districts layer to a new blank map and check that the CRS has been set to epsg:27700.
· You’ll see that at the moment this covers the whole of England and Wales. Use Select by expression to select the feature for Leeds (use the LAD21NM field) and save it as a new geopackage layer. You can then remove the original layer from your map.
· Style the layer so that it is just an outline with no fill.
[image: images/vector/LeedsLA_small.png]
The Local Authority area for Leeds.
We also need to restrict the extent of the MSOAs to match the Leeds Local Authority boundary.
· Add the Middle Layer Super Output Areas layer to your map.
· Use the Select within plugin to select features from the MSOA layer which intersect with the Leeds Local Authority layer. (Remember, you used this to select census output areas within Calderdale in the previous chapter).
[image: images/vector/SelectWithin_small.png]
Using the Select Within plugin to select just the MSOAs which are within Leeds Local Authority District.
· Once you have only the MSOAs within the boundary of the Leeds Local Authority selected, save them as a new geopackage layer.
· Again, you can remove the original layer from your map.
· Style the layer so that it is just outlines with no fill.
[image: images/vector/LeedsMSOA_small.png]
The Leeds MSOA boundaries within the Local Authority Boundary.
[bookmark: crime-data-for-leeds]Crime data for Leeds
All the police forces in England, Wales and Northern Ireland publish monthly data on reported crimes. This is freely available to download from the data.police.uk website and we’ll use data for Leeds to carry out an assortment of vector analysis processes.
· Go to the data.police.uk website and have a look at the information there.
· When you’re ready click on the Downloads link to download data in batches.
· Use the Date range: dropdowns to choose data for a single month. It doesn’t matter which month you choose. I used January 2024 for the examples in this chapter, but you can use the latest month available on that page.
· In the list of police forces put a tick next to West Yorkshire Police - this is the force which covers Leeds.
· Check that Include crime data is ticked.
· Then click on the button to Generate file
· For a single month for a single force it shouldn’t take long to generate the data, so on the next page click on the Download now button to download the data.
· As usual move the downloaded data to your project folder and unzip it.
You should end up with a folder for the month that you selected, which contains a csv file.
[bookmark: adding-the-crime-data-to-qgis]Adding the crime data to QGIS
Open the csv file in a spreadsheet program or text editor to have a look at the contents.
[image: images/svg/help_outline-black-24dp.png] What location information does the csv contain?
You need to know how you will bring the data into QGIS. What location information does the csv file contain? What are the titles of the columns that give you this information? What is the CRS likely to be?
You will be using this data for analysis, so you will also need to reproject it to match the rest of your data. The Download page includes a link to an About page. If you look down that there is a statement quite a bit of the way down which says
Anonymised in line with the location anonymisation process. Converted to WGS84 longitude.
And a similar one for latitude. This should tell you that we need to reproject the data back from WGS84 to British National Grid.
Once you can answer the questions above, go back to your project in QGIS, the one that you added the boundary data to, and add the crime data using the Spreadsheet plugin.
· Set the Geometry to EPSG:4326, which is WGS84.
· Set the X field to Longitude and the Y field to Latitude.
[image: images/vector/SpreadsheetPlugin_small.png]
Importing the crimes spreadsheet via the Spreadsheet plugin. Don’t forget to set the CRS to WGS84.
· Export the points to a geopackage layer, reprojecting it to British National Grid in the process.
Once you have the data in your map and reprojected, you also need to clip it to the extent of the Leeds boundary.
You need to reproject the data before you can clip it, or the different CRSs could cause some problems.
To restrict the data to Leeds:
· Use either Extract by location or Select by location and export the selection to restrict the points to the Leeds Local Authority.
· You can then remove the points layer covering the whole of West Yorkshire from your map.
[image: images/vector/LeedsCrime_small.png]
The Leeds Local Authority with crime data for January 2021 and MSOA boundaries.
[bookmark: leeds-census-data]Leeds Census data
We’ll use census data to provide the population figures for each MSOA.
[image: images/svg/create-black-24dp.png] Download census data
Use the instructions from the chapter on using census data to download population data. Unlike the census data chapter, use the data for Middle Super Output Areas and Intermediate Zones, not Output Areas and Small Areas.
Once you have the data for bulk download ts007a, you should have a csv file called census2021-ts007a-msoa.csv.
[bookmark: preparing-the-census-data]Preparing the census data
Once you have downloaded your data, move it to your project folder and unzip it.
You will need to clean up the column headings before adding the file to QGIS and can do this by changing Age: Total to AgeTotal and deleting the other Age columns.
Then you will need to Join the data to the MSOA layer you prepared in the previous section in the way that you joined the data to the boundary data in the census chapter.
[image: images/vector/AddingVectorJoin_small.png]
Setting up the vector join between the census population data and the MSOA boundaries.
Joining this data won’t change the appearance of your map, but once you’ve done it, you should have an MSOA layer for which the attribute table includes the population of each area.
The population field will probably be a text data type at the moment, and for analysis we are going to need it to be numeric. So the final preparation stage is to refactor the MSOA layer so that we can change the data type, and while we are at it, tidy up any unhelpful field names.
· Use the Refactor fields tool to change the data type of the population field in the MSOA layer from Text (string) to Whole number (integer - 64bit) if necessary.
· Save the refactored file as a new layer.
[image: images/vector/RefactorFields_small.png]
Using the Refactor Fields tool to change the name and the data type of the joined population field.
You will need to style the new layer so that it is outlines with no fill, and you can remove any other MSOA layers that you have generated from your map, to keep it tidy.
[image: images/vector/MSOAtableWithPopulation_small.png]
The attribute table of the refactored MSOA layer showing the population field taken from the census data - you may well have named your fields differently.
[bookmark: background-map]Background map
You can choose to use either a background map from XYZ tiles, or download a background layer from Digimap. If you decide to download data it is probably worth downloading the 1:250 000 raster data as a general background. It may be worth downloading the VectorMapDistrict raster data too, in case you wish to zoom in and look at the data in detail.
If you use the Digimap background layers you might want to fade them by using opacity and setting Greyscale to By Luminosity under Layer Rendering. They are otherwise strong colours which don’t allow your data to show well.
[image: images/vector/LeedsBackground_small.png]
All the data layers on the map so far. The background is the 1:250 000 raster layer from Digimap faded with some opacity.
[bookmark: displaying-data-as-a-form-of-analysis][bookmark: _Toc165644514]Displaying data as a form of analysis
Analysis does not just mean running tools and generating new output. You can also analyse data by displaying it on a map in certain ways. In this way it can become possible for you to pick out patterns in the data.
We’ll style the crime data in a variety of ways to look for patterns, such as where the most crimes take place, and whether there is a pattern in the type of crime.
[bookmark: categorizing-data]Categorizing data
Start by looking at the attribute table for your crime data. There is a column for Crime type which gives information about each crime such as whether it was a Burglary or Anti-social behaviour.
The simplest way to display the data would be to categorise the points by the type of crime.
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as categories in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select your crimes layer in the Layers panel and open the Layer Styling panel.
· Set the type of styling to Categorized and the Value to the Crime type field and click to Classify.
· It’s probably a good idea to untick the all other values symbol.
[image: images/vector/CrimeCategories_small.png]
The categorized crime types. Your colours will vary as these are initially set to random colours.
Now zoom in and pan around and have a look at your map.
[image: images/svg/help_outline-black-24dp.png] Can you spot any patterns in the type of crime?
You may not be able to, that doesn’t matter! There may not be anything obvious. In this case, when you are viewing the data for the whole of Leeds, the points are rather densely displayed and there is a lot of overlap.
You can also try looking at individual categories to see whether that accentuates any patterns or not. For example, where does the densest concentration of Public order crimes occur?
[bookmark: viewing-data-with-a-heatmap]Viewing data with a heatmap
Heatmaps can show dense point data more effectively than just displaying the points. They are a way of interpolating data to show density. If you remember, we have already covered interpolating point data to a raster surface in a previous chapter, this is another method which is more relevant to the data we are using here. There are a couple of ways to display a heatmap.
[bookmark: creating-a-heatmap-with-styles]Creating a heatmap with styles
If you have a vector point layer for which you wish to show density, the easiest way to do so is by setting the style for the layer.
[image: images/svg/videocam-black-24dp.png] Setting vector styles for a heatmap in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To display your point data as a heatmap:
· Right-click on your crimes layer in the Layers panel and select Duplicate layer. This adds the copy as a new layer in your map. Remember though, that this layer still references the same dataset, it’s just that you can now change the styling but still go back to the original version of the layer styling if you wish to.
· Select the visible copy of the crime layer in the Layers panel. Don’t worry about the other version.
· In the Layer Styling panel set the type of Styling to Heatmap - note that this can take a while to redraw, so your map may disappear for a short while.
· The default Color ramp is white to black, for a heatmap it probably makes more sense to choose the Blues colour ramp, so that the densest areas are the darkest blue.
· Make sure your boundary layers display above the heatmap.
[image: images/vector/HeatmapCrime_small.png]
The Heatmap settings and output for the crime layer. Note that I have the crime data layer beneath the boundary layers.
The Radius controls the area over which each point has influence.
· Try changing the radius setting, for example to 30 instead of 10, and have a look at the difference it makes to the heatmap. Be aware that the higher you set it, the longer the map will take to redraw.
Note that the measurement is in Millimetres. This is millimetres on the map canvas, so if you zoom in close the area of influence changes.
· Set the unit of measure to Map units, which in the case of British National Grid should be metres on the ground.
· You’ll then need to change the Radius to a much higher number to see the difference, for example, 1000. That will then make each point influence the area for a 1 km radius.
If you zoom in and out on the map now you should be able to see that the area covered by the darkest colour doesn’t change compared to the boundary data.
[image: images/svg/info-black-24dp.png] Taking a screenshot to check changes
I found that taking a screenshot of the heatmap before each change made it easier to see any differences, otherwise when QGIS took a while to redraw the heatmap I forgot what the previous version had looked like!
· Set the Layer blending mode to Multiply for your crimes layer (heatmap) so you can see the names of the locations. You may find a bit of opacity effective too, it’s up to you.
[image: images/vector/HeatmapCrimeMultiply_small.png]
The vector heatmap with radius set to map units and blend mode to Multiply to allow the background map to show.
[bookmark: weighting-the-heatmap-by-classification]Weighting the heatmap by classification
It is also possible to weight the points by classifying the crime type, but to do this you first need to add a new calculated field to the attribute table.
[image: images/svg/videocam-black-24dp.png] Using the field calculator to weight vector data in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the attribute table for the Leeds Crimes layer and open the Field calculator.
· We want to create a new field so fill in an Output field name such as Weighting. Leave the field type as Integer (32 bit) as we only need whole numbers.
· It is necessary to create an expression to assign the weightings. Type the following into the expression box using the elements from the central panel to help you.
For example, if you select Crime type under Fields and Values you should then be able to click on All Unique to the right and get a list of each crime type which you can then enter in the expression. I’ve given an example of just two weightings here, but you could set as many as you wish.
CASE
WHEN "Crime type" = 'Criminal damage and arson'  THEN 10
WHEN "Crime type" = 'Vehicle crime' THEN 8
ELSE 1
END
[image: images/vector/FieldCalculator_small.png]
Adding a weighting to the crimes attribute table. It is possible to add as many weightings as you need to.
Disclaimer: Please note, I’m not intending any judgement about the seriousness of different crimes with this example, just demonstrating how weighting can work with this sort of data.
You should be able to Preview your output below the expressions box.
· When you are happy with the expression click on OK to write the values to the attribute table.
· Check that the attribute table has been updated correctly, then click to Save the edits and toggle editing off by clicking on the pencil icon.
· Now you should be able to enter the Weighting column in the Weight points by dropdown and see what difference it makes to your map.
[image: images/vector/HeatmapWeighted_small.png]
The weighted vector heatmap layer with layer rendering set to Multiply.
Feel free to experiment by adding more or different categories, and weighting them as you wish between 10 and 1.
[image: images/svg/help_outline-black-24dp.png] What do you notice if you look at the Crime heatmap layer in the Layers panel?
Can you use the layers panel to see the values for your heatmap?
It should be obvious that you can’t. This is a problem with using styling to display heatmaps, it isn’t possible to provide a key for them. Instead you need to generate a raster heatmap using a different technique, the Heatmap (Kernel Density Estimation) tool.
[bookmark: Xe93513fcfadc4837bbde2448cc2a76925bb9e78]Creating a raster heatmap from point data
It is also possible to create a heatmap as raster output and this has the advantage of being able to generate a key to include on your layouts.
[image: images/svg/videocam-black-24dp.png] Creating a raster heatmap in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To create a raster heatmap:
· Make the vector heatmap layer invisible.
· From the Processing toolbox search for Heatmap and open Heatmap (Kernel Density Estimation).
· Enter your crime layer as the input Point layer. (Make sure you use the one that you added the weighting to. Although the Layer panel entries point to the same datasource, there can be a delay in refreshing the new attributes.)
· Set the radius to the same as you decided to use for the styling - in this case you will choose meters as the unit rather than map units. They are the same in this case.
· To save processing power set the Pixel size x and y to 5.00. You can always run the tool again with a lower pixel size if you decide you want more detail and have a good enough computer.
· Under Heatmap click on the three dots to save your output to your computer.
· If you want to weight the result again you can drop down the Advanced Parameters and enter your weighting field under Weight from field.
· When you are ready run the tool.
[image: images/vector/HeatmapTool_small.png]
Filling in the Heatmap dialog.
[image: images/vector/InitialRasterHeatmap_small.png]
The initially generated raster heatmap.
The result may look rather odd at the moment, but use the Layer Styling panel to change the type of styling to Singleband pseudocolor and set the Blues color ramp again. You’ll probably need to click on Classify to set the classes properly. Once you’ve done that you’ll be able to experiment with the Mode and classes to see what displays the density of crime across the Leeds Local Authority area the best.
Part of the point of generating the heatmap with the processing tool is to make it possible to add a key to a layout so have a look at the layer in the Layers panel. You should be able to see what value the colours indicate now.
Try different colour ramps, or try editing the Blues colour ramp so the lower values are not so pale.
Again, styling the layer with the Multiply blending mode appears to work better than making it transparent, but experiment to see what works best on your map.
[image: images/vector/RasterHeatmap_small.png]
The styled raster heatmap with legend in the Layers panel.
[bookmark: relating-point-data-to-areas][bookmark: _Toc165644515]Relating point data to areas
So far we’ve been looking at the crime data in relation to the whole of the Local Authority area of Leeds, but it would be useful to be able to break it down into smaller areas, in this case the Middle Layer Super Output areas, or MSOAs, that you already have on your map. We already have population data for the MSOAs joined to the attribute table, if we can also add a figure for the total number of crimes in each MSOA then we can work out the number of crimes per head of population in each MSOA and display that on our maps.
[bookmark: X650a7d2241c44fdc55ecec2c1d0b698f726d4f6]Counting the number of points within each polygon
Luckily, we don’t need to carry out this process manually, there is a tool in the processing toolbox which will count the number of points from a layer which occur within the area of each of the polygons in another feature class.
[image: images/svg/videocam-black-24dp.png] Counting the number of points within each polygon in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To count the number of points within each polygon:
· In the Processing Toolbox search for Count points and open the Count points in polygon tool.
· The input Polygons are the MSOA layer which already contains the population data.
· The input Points are the Leeds crimes layer. It doesn’t matter whether you use the original layer or the copy - they both link to the same attribute table.
· Under Count field name give the new field a name that tells you what data it contains, e.g. CrimeTotal.
· Click on the three dots at the end of the Count line and tell QGIS where to save the output and what to call it.
· Click on Run to create the new layer.
[image: images/vector/CountPointsInPolygon_small.png]
Filling in the form to count the number of crimes in each MSOA polygon.
We’re only adding the total number of crimes here, but it would be possible to classify them based on the crime type.
The new layer will look the same as the existing MSOA layer. Don’t worry about styling it yet.
Check the attribute table of your new layer and QGIS should have added a new column to the end of the table which shows the total number of crimes in each MSOA.
Remove the previous MSOA layer from your map to save confusion later.
[bookmark: Xbb42d43ae6b2b211383dd3ab55689b48932662e]Calculating the number of crimes per head of population
Now that you have both the total population and the number of crimes in the same feature class it is easy to work out the number of crimes per head of population.
[image: images/svg/videocam-black-24dp.png] Using the field calculator to create new fields in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To calculate the number of crimes per head of population:
· Open the attribute table for your new MSOA layer
· Click to open the Field Calculator
· Create a new Decimal number (real) field called Crime_per_pop, or something that tells you what data it contains.
· In the expression area construct an expression which divides the number of crimes by the total population. Remember you can use the Fields and Values part of the central box to find the field names accurately.
· Use the Preview below the expression box to check the output.
The result is likely to be a number with rather a long string of digits after the decimal point. Remember that it is possible to round the result to a more reasonable number of decimal places.
· Change your expression so that the number is rounded to 5 decimal places. Remember you can search for round in the central box and you will be shown how to use it in an expression on the right-hand side.
· When you are happy with your expression click on OK to add the calculated field.
· Remember to save the new edits and click on the pencil icon to stop editing mode.
[image: images/vector/FieldCalculatorCrimePop_small.png]
Calculating the number of crimes per total population for each MSOA.
Check the result in the attribute table. These are small numbers, but we can display them in a way which allows us to see comparisons between the MSOAs in Leeds.
[bookmark: creating-a-choropleth-map]Creating a choropleth map
A choropleth map can be used to show ratios in your data. Examples include population per square kilometre, or crimes per head of population. The data is applied to an area and it becomes easy to compare different areas.
We’ll use this technique to map the number of crimes per head of population in each MSOA in the Leeds Local Authority.
[image: images/svg/videocam-black-24dp.png] Displaying data as a choropleth map in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To style the MSOAs by crimes per head of population do the following:
· Open the Layer Styling panel for your MSOA layer which has the result of the previous calculation, that is, the number of crimes divided by the total population for each MSOA.
· At the top of the panel choose to style as Graduated
· Set the Value to your calculated column
· Choose the colour ramp that you want to use, e.g. Blues.
· Click on the Classify button to apply the styles.
· It’s a good idea to set transparency either via the Symbol colour, or via the Layer Rendering, where it’s worth trying the Multiply blending mode.
· Remember to make the heatmap layer invisible or you could end up with a rather confusing result.
[image: images/vector/GraduatedCrimes_small.png]
The number of crimes per head of population by MSOA styled as a choropleth map with a graduated classification. This uses the default settings with the Blues colour ramp.
Now that you have the basic styling, you can experiment with the settings to see how you can best display your data.
· For example, try changing the Mode to Equal interval or Natural breaks.
· You can also change the number of Classes, though it’s not a good idea to set too many. The usual recommended maximum is six, unless you have a good reason to use more. Higher than six it can become difficult to see the categories on the map.
· You can also try alternative colour ramps to see what effect you get.
There are principles for styling these choropleth maps that you can find in the cartography texts on the reading lists, but in the end it comes down to experience, both as a map-maker and as a scientist. Experiment and see what works for your data.
[bookmark: viewing-a-histogram]Viewing a histogram
The Layer styling panel also allows you to view a histogram of your data. That is a graphical view of your data showing how many instances of each value or group of values you have.
· On the Layer styling panel look just underneath the Colour ramp. You should see that you currently have the Classes tab selected, now click on the Histogram tab.
· Click on the button to Load Values
The histogram showing your data should appear, showing how many MSOAs are in each colour class, and what the boundaries of those classes are.
[image: images/vector/Histogram_small.png]
The histogram for my choropleth map, showing the distribution of data in the classes.
In my example (Classes are set to Equal Count (Quantile)), once I open the histogram, it suddenly becomes possible to see that there is a MSOA which has a comparatively high value for crimes per head of population compared to the other MSOAs.
I can now go back to the Classes tab and change the Mode then check the Histogram again to see which setting makes it most clear that there is this single MSOA in a class of it’s own.
It is also possible to manually adjust the classes using the Histogram.
· Use the mouse to “grab” one of the class boundaries in the histogram and drag it to left or right.
· It is also possible to click on the histogram to add another class, though it only appears to be possible to remove one by going back to the class tab and resetting the number of classes.
[bookmark: showing-statistics]Showing statistics
It is possible to open a window showing basic statistics for a layer.
· If you don’t already have the Attributes toolbar open go to View > Toolbars and put a tick in the box next to Attributes.
[image: images/vector/AttributesToolbar_small.png]
The Attributes toolbar with the Show Statistical Summary button shown.
· Once you have the toolbar, click on the Show Statistical Summary button.
· Check that you have the correct MSOA layer selected in the dropdown box at the top of the Statistics window
· Select the crime per population field
The statistics for your data should be shown in the window. Have a look at what is available to you.
[image: images/vector/Statistics_small.png]
The statistics for the MSOA crimes per head of population field.
[bookmark: Xd1a422052d3b0865d1094af6092d93cffab0d03][bookmark: _Toc165644516]Creating graphs with the Data Plotly plugin
You’ve already seen how to create a histogram of your data, but by installing a plugin it becomes possible to create other graphs too. We’ll have a look at the plugin by plotting the population of each MSOA against the total number of crimes.
· Open the Plugin Manager, search for Data Plotly in the list of Not installed plugins, and Click the button to install it.
· Data Plotly opens as a panel. If you have the icon on your toolbars, you can just click on that. Otherwise go to View > Panels > DataPlotly.
The tool should open as a panel to the right of your map.
[image: images/vector/DataPlotlyPanel_small.png]
The initial view of the DataPlotly panel.
· Start by choosing the Plot type, e.g. Scatter plot
· Set the layer to the MSOA layer with population and numbers of crimes
· Set the X field to Population
· Set the Y field to Total of crimes
· For now leave the rest of the settings as they are and click on Create Plot at the bottom of the panel.
After a short pause the plot should be generated on a new tab. You may need to make the panel wider, or “pop” it out of the QGIS window so that you can see the plot correctly.
[image: images/vector/DataPlotlyScatterGraph_small.png]
A scatter plot created in DataPlotly showing MSOAs with Population and total number of crimes.
Have a look at the plot, then explore the parameters and settings available to you. The second tab on the left allows you to add a title and various other elements to the plot.
On the first tab you can try out different types of plot and different ways of displaying the data from your map. You may wish to use the Clean Plot Canvas button between each experiment as otherwise they all get added to the same view.
When you have a plot that you want to keep you can use the buttons at the bottom right of the plot window (third tab down) to export the plot as either a html file, or an image.
Once you have DataPlotly installed you can also set up plots from within a layout so they appear next to your map and can update automatically.
You can find out more information about the DataPlotly plugin on the github webpage.
[bookmark: final-layout-for-vector-data-analysis][bookmark: _Toc165644517]Final layout for vector data analysis
For your final layout for this chapter try adding multiple maps showing different views of your data, e.g. the categorized point data, the heatmap and the choropleth map with the crimes per head of population. You could also include the graph from the Data Plotly plugin.
[image: images/vector/FinalMap_small.png]
Possible final map for this chapter showing three maps with different techniques for showing vector data.
Once you have completed your layout, export it as either an image or a pdf.
[bookmark: Xcf2956635a638715ed4c9e27d7a51955c05dddb][bookmark: _Toc165644518]Recommended reading for vector data analysis
Many of the books in the reading list[footnoteRef:1] have general information about vector data analysis. Suggestions include the following: [1:  The reading list is available in Minerva and from the library (search for the number of this module).] 

· Darkes and Spence (2017) has a section on ways to present data which includes useful information, see pages 27-35, in particular Mappable Statistics, pp. 28-29; Choropleth maps p.30;
[bookmark: further-information]Further information
· It is worth looking at QGIS Tutorials and Tips for more information on a range of vector analysis techniques.  
[bookmark: environmental-decision-making][bookmark: _Toc165644519]Environmental decision making
Last Modified: 19 Apr 24, 15:01:28
[bookmark: alternative-chapters-1][bookmark: _Toc165644520]Alternative chapters
This chapter covers the use of GIS to analyse multiple raster data layers through both multi-criteria analysis and least-cost paths.
Note that this chapter is optional. You can choose between working through this one, or the chapter on vector analysis.
Both chapters contain techniques that past students have gone on to use in their dissertations.
This decision making chapter is mainly raster-based again, and covers combining a series of layers for complex analysis using physical geography examples.
If you are more interested in human geography-type applications of GIS you may find the vector analysis chapter more useful.
Of course, you are welcome to work both chapters if you wish.
[bookmark: Xeaad2d95890aae4ee9d6191db13cd6fe7dfa8d9][bookmark: _Toc165644521]Learning outcomes for Environmental Decision Making
When you have completed this section of the workbook you should be able to
· use GIS to analyse multi-criteria models to provide answers to complex questions
· explain how to use least-cost pathways to suggest the optimum route from a source to a destination
· give examples of how these analysis techniques can be used to solve environmental questions
[bookmark: introduction-1][bookmark: _Toc165644522]Introduction
In previous exercises you have processed data and added multiple layers to the same map to show where they overlap. You have also selected data that overlaps or intersects particular features in other layers. This is useful, and produces some informative maps, but in this chapter you will learn how to go further and combine data layers to produce a single layer that answers questions such as
· Where am I most likely to find a particular plant?
· Where would be the best place to site some bee hives?
· How will hedgehogs be able to move around the University of Leeds campus?
The first part of the chapter will cover multi-criteria analysis, then the second part will go on to look at least-cost paths.
[bookmark: Xf20a7ed6a2d8c79c22fffb916aeec7c98f792cd][bookmark: _Toc165644523]Data required for the environmental decision making exercises
[image: images/svg/warning-black-24dp.png] Warning
Being able to find, download and prepare your own data is an essential part of using GIS. For the exercises in this chapter you will need to download several datasets. While these should not take too long to download and prepare, don’t leave it until the last minute. Websites can become unavailable either permanently or temporarily, or computers can crash.
If there are problems with a website then try again later. If the problems persist please get in touch with me (c.e.gordon@leeds.ac.uk) and I will try to contact the site or find an alternative source of data.
[bookmark: data-to-download]Data to download
Log in to Digimap and download the following datasets from Ordnance Survey data download for the area around Otley in Yorkshire that is shown in the image below:
· Ordnance Survey Terrain 5 DTM in asc format - from Land Height Data
· OS Open Map Local Vector data in SHAPE format - from Vector Data
[image: images/decision/DigimapOtleyOML_small.png]
Downloading data for the Otley area from Digimap Ordnance Survey Download.
Then go into Environment Data download and download the following data for the same area:
· Great Britain (vector) in Land Cover Map 2021 - from Environment Data Download. Choose to download as a GeoPackage.
[image: images/decision/DigimapLandCover_small.png]
The data to download from Digimap Environment Data Download.
· Also download DecisionMaking.gpkg from Minerva for this week.
As usual save all the data to your project folder.
[bookmark: preparing-data]Preparing data
Start by unzipping all the data, putting it in a folder for this project, and having a look at what you have downloaded. What formats are the data in, and do you have multiple tiles of data for any dataset that will need to be merged?
[bookmark: defining-the-study-area]Defining the study area
The DecisionMaking GeoPackage includes a layer called StudyArea which defines the area that we will be using when processing our data.
· Start by adding the StudyArea layer to a new map in QGIS. This should automatically set the map CRS to British National Grid (epsg:27700). If it doesn’t, set that now.
· The layer should be styled as an just an outline, if it isn’t set that up now.
· Don’t forget to save your map from time to time.
The other two layers won’t be needed until the second part of the chapter, so just keep them in the GeoPackage for now.
[bookmark: os-terrain-5-dtm]OS Terrain 5 DTM
You should have more than one tile of this DTM dataset.
Follow the instructions from the chapter on elevation models to merge the tiles so that you have a seamless dataset. Don’t forget to check the properties of the tiles before you merge them, e.g. what is the cell size, what is the data type, what is the CRS?
To save processing time and computer space you should also clip the dtm to the StudyArea vector layer extent. You can then remove the merged DTM which covers the larger area.
You don’t need to worry about symbolising the dtm as it won’t need to be visible on the final map.
[image: images/decision/DTM_small.png]
The DTM layer covering the study area around Otley.
[bookmark: os-open-map-local-vector-dataset]OS Open Map Local vector dataset
The OS Open Map Local vector dataset consists of a number of shapefiles. For this exercise the only layers that you will need are the SE_Road and SE_SurfaceWater_area layers, so add those to your map now.
The layers that we’ve downloaded cover the whole of the SE 100 km grid square but we only need the data for the Otley area. Use Save Features As... to export the Roads and SurfaceWater shapefiles as new layers in a GeoPackage, setting the Extent to the extent of the StudyArea layer. The layers will still overlap the edges of the study area as this process doesn’t cut individual features, but this will cut down the amount of data that you are working with considerably.
Make sure that the road dataset for the smaller area is on your map, and remove the original layers. You can remove the smaller SurfaceWater_Area layer too, as you won’t need that until the second part of the chapter.
[image: images/decision/RoadSurfaceWaterArea_small.png]
The Road and Surface Water Area layers. Clipped to cover the study area. Your colours will vary.
You won’t need the original data now, so to save space on your computer delete the folder containing the shapefiles for the Open Map Local vector data. If you need it again you can unzip it from the original download.
[bookmark: land-cover-2021-data]Land Cover 2021 Data
The land cover data is a single layer within a GeoPackage so drag and drop that onto your map now. You should find a layer consisting of polygon shapes which all fit together. At this stage all the polygons are the same colour, which isn’t helpful for interpreting the data. You need to style the data.
[image: images/svg/help_outline-black-24dp.png] How do you style this layer?
Have a look at the attribute table of the layer. Is it obvious which field you should use to style it according to land cover?
You probably answered “no” to the question above! All the fields contain a list of numbers, so it isn’t obvious what they mean.
Luckily there is a simple way of styling the land cover data with the correct classes and colours.
[bookmark: X0b821123af7b846b0bf6fcb6a1496e19c985c6a]Styling land cover data with a qml style file
When you unzipped the downloaded zip file you should also have seen a folder called docs. Enter that folder and open the pdf that it contains. That is the product documentation and gives you information about the data you have downloaded. Have a quick look at the document. It includes a table (on page 5) which links the Identifiers to land cover classes.
The folder also includes a series of style files with extensions such as .lyr and .qml. The .qml files will work in QGIS. The .lyr file is provided for users of ArcGIS.
[image: images/decision/StyleFiles_small.png]
The contents of the docs folder showing the pdf containing the product documentation and the style files.
[image: images/svg/videocam-black-24dp.png] Applying styles to a layer with a qml file in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To apply styles to the land cover data from a qml file:
· First open the Layer properties for the land cover data.
· Click on the Style button at the bottom of the panel and Load style....
· The Database Styles Manager should open. Check Load Style is set to From File.
· Click on the three dots (ellipsis) button at the end of the File line.
· In the dialogue that opens, navigate to the docs folder for the land cover data and select either of the .qml files. The _cb_friendly part of the file name indicates colour blind friendly, so that is probably the best to use.
· Click Open then in the Database Styles Manager click on Load Style.
If you look at the Symbology tab at this stage, the styles should be loaded.
[image: images/decision/StylesLoaded_small.png]
The styles from the qml file loaded into the Symbology of the land cover layer.
· Click OK and the styles should be applied to the whole layer on your map.
[image: images/decision/StylesApplied_small.png]
The land cover layer with colour blind friendly styles applied.
Have a look at the resulting map.
[image: images/svg/help_outline-black-24dp.png] What is the dominant land cover on the map?
You should be able to work out that it is category 4, Improved grassland, which if you’ve explored north of Leeds at all shouldn’t come as much of a surprise.
[image: images/decision/ChevinView_small.jpg]
The view over the improved grassland of Wharfedale from Otley Chevin.
[bookmark: the-map-so-far]The map so far
Once you’ve added all four layers, your map should look something like the one below, though most likely with different colours. Note that I’ve used blending mode on each layer to allow them to all show and applied a hillshade style to the DTM layer then moved it to the top of the layers panel.
[image: images/decision/InterimMap01_small.png]
QGIS map with DTM, rivers and land cover added and styled. The colours for the land cover are random so yours will look different to mine.
[bookmark: background-map-1]Background map
In addition add a background map so that you can see where places are located. Either download something suitable from Digimap or use one of the layers from the XYZ Tiles e.g. Thunderforest Atlas or OpenStreetMap.
[bookmark: analysing-multiple-criteria][bookmark: _Toc165644524]Analysing multiple criteria
Now that we have the data on our maps we can start to run processing tools to enable analysis, and hopefully an answer to the question of which areas on this map would be suitable locations for bee hives.
In the first part of this chapter we’ll look at an example about locating bee hives as outlined by Zoccali, P. et al. 2017, [footnoteRef:2] but simplify it somewhat so that you can get an overview of the GIS techniques involved. If you know a lot about bees you may not agree with some of the criteria below, but for the sake of this exercise they give us a starting point. [2:  For example, see Zoccali, P., Malacrinò, A., Campolo, O., Laudani, F., Algeri, G.M., Giunti, G., Strano, C.P., Benelli, G., Palmeri, V. 2017. A novel GIS-based approach to assess beekeeping suitability of Mediterranean lands, Saudi Journal of Biological Sciences, Volume 24(5), pp. 1045-1050. DOI: 10.1016/j.sjbs.2017.01.062] 

The criteria that we will take into account are:
1. Altitude - this tends to affect the average temperature and also the types of plants that will grow, so we will assume that lower altitudes are better than higher.
1. Land cover - land cover with a higher potential for pollen-producing flowers is likely to be much more successful for bees.
1. Proximity to roads - this is useful when transporting hives or when visiting the hives to check on the bees and collect the honey.
The article linked from the footnote above also looks at temperature between April and October and proximity to rivers and lakes.
It would be possible to do the analysis using vector layers, for example, by creating a buffer around the roads; clipping to roads below a certain altitude, then intersecting the best land cover with the clipped buffer. This would give an answer, but what if you wanted to weight the different datasets, e.g. if the proximity to a road was more important than the altitude, and the land cover was more important than either?
Instead it is possible to convert all the data to raster layers, normalise them to the same values, usually 0-1, then combine them all in the raster calculator and weight some layers more than others. This is the method we will use in the following exercises.
[bookmark: proximity-to-roads]Proximity to roads
The first criteria we’ll prepare the data for is proximity to roads.
[bookmark: rasterizing-the-roads]Rasterizing the roads
We have a vector layer for roads so the first step is to rasterize this so that the roads have a value of 1 and the spaces between have a value of 0.
· In the menu bar go to Raster > Conversion > Rasterize (Vector to Raster)
· The Input Layer is the roads vector layer
· A fixed value to burn needs to be 1 (the tool doesn’t produce the right result if you don’t fill this in!)
· Set Output raster size units to Georeferenced units
· The Width and Height resolution should be 5 to match the DTM - this will make analysis simpler later.
· Set the Output extent to the same as the StudyArea layer.
· Choose where to save the output and give it a name.
· Run the tool.
[image: images/decision/RasterizeRoads_small.png]
The Rasterize tool to convert the vector roads to a raster layer.
The resulting layer should look very similar to the vector roads layer, but will look pixelated if you zoom in to some of the lines. We set the resolution to 5,5 in georeferenced units, so each pixel is 5 x 5 metres.
[image: images/decision/RasterizedRoads_small.png]
The rasterized roads - the original vector roads are still just about visible as thin lines.
[bookmark: Xc5bbc02f3ad9ed49b46da239aec5d3adcf2b6d7]Creating a raster showing proximity to roads
The next step is to generate a layer showing proximity to roads across the whole area. For this we can use the Proximity (raster distance) tool.
[image: images/svg/videocam-black-24dp.png] The Proximity (raster distance) tool in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the Processing toolbox and search for Proximity
· Open the Proximity (raster distance) tool from the GDAL Raster Analysis toolbox.
· The Input layer is the raster road layer.
· The Distance units are the Georeferenced coordinates
· Under Proximity map select where to save your output and give it a name.
· Then Run the tool.
[image: images/decision/RoadProximity_small.png]
Generating a raster layer showing proximity to roads.
The output looks a bit odd, but if you view it with the vector roads layer above it in the Layers panel you should be able to see that the black areas are the areas closest to roads and the white areas the farthest away. The Layers panel shows the distances in map units, which in this case should be metres.
[image: images/decision/ProximityToRoads_small.png]
The lines show the roads. Black shows the areas closest to the roads, white the areas that are farthest away.
[bookmark: normalising-the-proximity-raster]Normalising the proximity raster
When we combine the data for the three criteria we want to be able to weight them. This means that we need to normalise all the layers to the same scale, such as 0 to 1 where
· 1 = most suitable
· 0 = least suitable
At the moment the proximity to roads raster has a scale of something like 0 to 2232.71 (yours may vary), where 0 is actually the most suitable.
It is possible to reverse the numbers and convert them to 0 to 1 in a single process by using the Fuzzify raster (linear membership) tool.
[image: images/svg/videocam-black-24dp.png] Normalizing raster layers with the Fuzzify raster tool in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the Processing Toolbox search for fuzzify and open the Fuzzify raster (linear membership) tool from the Raster Analysis toolbox.
· The input is the road proximity layer
· Set the Low fuzzy membership bound to the current highest value. in my case that was 2232.71, yours may well be different - check the Layer styling panel, and drop down Min / Max Value Settings to set Accuracy to Actual (Slower) so that you know you are working with the correct values.
· Set the High fuzzy membership bound to the current lowest value - 0.0000
· Under Fuzzified raster select where to save the output and give it a name.
· Click on Run.
[image: images/decision/FuzzifyRasterRoads_small.png]
Using the Fuzzify Raster tool to convert the proximity to roads to 0 to 1 and reverse the values.
The output should look similar to before, but this time the highest value is 1, shown as white, and the lowest is 0, shown as black.
[image: images/decision/FuzzyRoadProximity_small.png]
The normalised proximity to roads layer.
The road data is now normalised and ready to use for multi-criteria analysis.
[bookmark: reclassifying-land-cover]Reclassifying land cover
The current land cover categories are simply code numbers, they don’t relate to suitability for bees, so the first thing we need to do is decide the suitability of each land cover type and use that ranking to reclassify the raster.
We could rasterise the land cover data first, then reclassify the raster with the raster calculator, but instead we will add the classification data to the vector layer and then rasterise the result.
[bookmark: X94186cd7e268885ac07748422ecf81067d265bf]Set the classification and join to the feature class
To convert the land cover classes to suitability we need to decide how to class them numerically from 0 (least suitable) to 1 (most suitable) and you can see my suggested classification in the table below. You are welcome to decide on your own classification!
	_mode
	description
	reclass

	1
	Deciduous woodland
	0.6

	2
	Coniferous woodland
	0.6

	3
	Arable
	0.6

	4
	Improved grassland
	0.6

	5
	Neutral grassland
	1

	6
	Calcareous grassland
	1

	7
	Acid grassland
	1

	8
	Fen
	0.6

	9
	Heather
	1

	10
	Heather grassland
	1

	11
	Bog
	0.6

	12
	Inland rock
	0

	13
	Saltwater
	0

	14
	Freshwater
	0.3

	15
	Supralittoral rock
	0

	16
	Supralittoral sediment
	0

	17
	Littoral rock
	0

	18
	Littoral sediment
	0

	19
	Saltmarsh
	0

	20
	Urban
	0.3

	21
	Suburban
	0.3


· Use a spreadsheet program (e.g. Excel (desktop only); Pages; LibreOffice Calc; Google Sheets) to create a .csv file containing the table above (with your reclass decisions in the final column). Make sure you save the file as .csv then close the spreadsheet program.
In the chapter on census data you joined a data table to the census boundaries and you’ll be adding the data from your csv file to the land cover feature class in exactly the same way.
[image: images/svg/videocam-black-24dp.png] Creating a classified raster from a vector layer with joins in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To join the csv file to the vector layer:
· Add the csv file to QGIS by dragging and dropping it from the Browser panel to the Layers panel. It won’t appear on the map.
· Open the attribute table of the land cover layer in the Layers panel - you should be able to find a column called _mode which matches the first column in your csv table. Close the attribute table again.
· Go the layer properties for the land cover layer and click on the Joins tab.
· Click the plus button to add a new vector join.
· The Join layer will be your .csv file containing the classifications
· The Join field and Target field should both be _mode
· You can tick Joined fields and just tick description and reclass, as the _mode field is already in the feature class.
[image: images/decision/AddVectorJoin_small.png]
Adding the vector join between the land cover layer and the .csv classification table.
· Click on OK to perform the join, then on OK again to close the layer properties.
If you open the attribute table of the land cover layer again you should be able to see that the description and classifications have been added to all the fields, matching the two _mode columns.
[image: images/svg/create-black-24dp.png] Options to make the join permanent and style the layer
This isn’t yet a permanent join. To make it permanent you can export the layer to a new feature class. You can then style the categories using the description field so that the legend is more helpful.
Alternatively in this case, we need to do another step before rasterizing the land cover ready for the multi-critera analysis, so saving the layer as a permanent join can be done in the same action.
[bookmark: rasterize-the-land-cover]Rasterize the land cover
The next step is to rasterize the land cover layer making sure that we keep the codes that we need for reclassification. Unfortunately to do this we need to convert the reclass column from a text data type to a numerical data type.
· Use the Refactor Fields tool to change the reclass field to a Decimal (double) data type and save the refactored feature class into a GeoPackage.
· You can now apply style categories to the layer using the new description field to make the legend more useful.
Now we can rasterize the layer with the land cover values (from the _mode field) intact.
· Open the Rasterize (Vector to Raster) tool
· The input is the refactored land cover vector layer
· Set the Field to use for a burn-in value to reclass
· Output raster size units should be Georeferenced units
· Set the width and height resolution to 5
· The Output extent should match the StudyArea layer
· Under Assign a specified nodata value... type -9999
· Under Rasterized browse to where you want to save the output and give it a name.
· Run the tool
[image: images/decision/RasterizeLC_small.png]
Rasterizing the land cover vector layer and ensuring that it keeps the land cover class values.
The output will be a grey-scale layer with the number of classes that you set - check the values with the Identify tool.
In this case I’ve ended up with a layer with three values between 0 and 1. I had to set the Layer Styling to Paletted/Unique Values then Classify to see the categories.
[image: images/decision/RasterizedLandCover_MCA_small.png]
The rasterized land cover layer with the reclassification applied and styling set to Paletted Unique Values.
As with the normalised proximity to roads layer, the most suitable areas have a value of 1, the least suitable have the lowest value.
[bookmark: normalising-the-dtm-layer]Normalising the DTM layer
Now we’ll move on to normalise the DTM layer to the 0 to 1 scale. In this case the lower altitudes are to be considered most suitable, so need to have a value closer to 1 than the higher altitudes do.
If your DTM layer covers a larger area than the StudyArea outline, use the Clip Raster by Extent tool to clip it to the same area using the StudyArea vector layer. We’ll get a better result when we normalise the DTM if the values are calculated only on the study area.
Once again we can use the Fuzzify raster (linear membership) tool.
Before you run the tool
· go to the Layer styling panel for your clipped DTM layer
· Go into the Min/Max Value Settings and check that Min/max is selected then change the Accuracy setting to Actual (slower).
· Make a note of the maximum and minimum values of your DTM layer.
Doing this may well change the minimum and maximum values slightly and will make a difference to the end result.
· Open the Fuzzify raster (linear membership) tool and fill in the details
· Have a go yourself using the instructions from before if necessary, remembering to add the lowest altitude from your Layers panel to the High fuzzy membership bound, and vice versa.
The result should look something like the image below with the valleys in white and the hill tops in the darker colours.
[image: images/decision/FuzzyDTM_small.png]
The normalised DTM layer.
[bookmark: determining-weights-for-each-criteria]Determining weights for each criteria
At this stage you need to spend a bit of time deciding on the relative weighting of your criteria.
· Which is the most important?
· How much more important than the other criteria is it?
· Which is the least important?
With three criteria this isn’t too difficult, but with more it rapidly becomes more complex.
· In a web browser go to AHP Priority Calculator. [footnoteRef:3]. [3:  Goepel, K.D. 2013. AHP Online Calculator – BPMSG. Business Performance Management Singapore. [Online]. [Accessed 8 April 2024]. Available from: https://bpmsg.com/ahp-online-calculator/.] 

AHP stands for Analytical Hierarchy Process and is a method of pairwise comparison, meaning that you can enter multiple criteria, rank them, and then obtain a percentage for each item as the output.
The AHP Online Calculator web page, where there is more information about the tool, recommends between 5 and 9 criteria, but we’ll work with a relatively simple example of three criteria for this exercise.
· Start by clicking on the AHP Priority Calculator link
· We have three criteria, which appears to be the default, so click Go
· Enter the criteria as shown below then click OK.
· Proximity to roads
· Altitude
· Land cover
[image: images/decision/AHP01_small.png]
Filling in the AHP Criteria Names.
· Once you’ve done that you should get a matrix showing each of your criteria paired with each of the others. For each comparison select which one you consider to be the most important and then select how much more important you think it is.
I entered something like the following:
· Proximity to roads is 4 times more important than Altitude.
· Proximity to roads is 3 times more important than Land cover.
· Land cover is 2 times more important than Altitude.
My results were the following percentages:
· Proximity to roads = 62.5%
· Land cover = 23.8%
· Altitude = 13.7%
Note that the results should add up to 100%!
[image: images/decision/PairwiseComparison_small.png]
My entries and results in the Pairwise Comparison web page.
Make a note of your results. Don’t worry about them too much and don’t worry if they aren’t the same as mine! You can experiment later.
[bookmark: Xf4493779b5b3b0a20ccfafb5e6a9dbf752bb0aa]Running the multi-criteria analysis to combine the layers
Finally you should have three layers all normalised to a range of 0 - 1 and a weighting for each one. You are now in a position to combine them and calculate the most suitable location for the bee hives.
You’ll be carrying out this final step in the raster calculator.
[image: images/svg/videocam-black-24dp.png] Multi-criteria analysis with the raster calculator in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the raster calculator
· Set up the output as usual
· In the Raster Calculation Expression box compile the following expression, using the names of your normalised layers and the weightings that you gained through the pairwise comparison.
("RoadProximityNormal@1" * 62.5) + ("LandCoverReclass@1" * 23.8) + ("DTMNormal@1" * 13.7)
[image: images/decision/SuitabilityCalc_small.png]
Calculating the suitability by combining the layers with weighting.
The expression is basically multiplying each value by the weighting, then adding them all together so that you get a result out of 100. The higher results being the most suitable.
Once you’ve run the calculation you should end up with a layer something like, but probably different to, the layer below.
[image: images/decision/SuitabilityOutput_small.png]
The output of the calculation showing the most suitable areas in the palest shades of gray.
You can now experiment with the weightings to see what different results you can come up with. I tried reducing the importance of the proximity to roads relative to the other two layers as otherwise my most suitable areas were all extremely close to roads.
When you are happy with your output try styling it as follows to show the most suitable areas for bee hives more clearly.
· In the layer styling panel change the symbology type to Singleband pseudocolor and choose a Color Ramp.
· Set the Interpolation to Discrete
· and the Mode to Equal Interval
· You may need to click on Classify to apply the settings.
· Apply transparency so that if you turn on a background layer you can see the places covered by the most suitable areas.
· You could edit the classes so that only the most suitable sites are styled.
[bookmark: the-final-suitability-map-layout]The final suitability map layout
The final step of any analysis is to display your results. Try creating a layout which shows your results and your recommendation for locating the bee hives. Don’t forget to include copyright information for both the data that you downloaded from Digimap, and for any other data layers that you have used.
When you have created a layout export it to either an image or pdf.
[image: images/decision/MCASuitability_small.png]
The final multi-criteria analysis map showing suitability of locations for bee-keeping based on the criteria we selected.
[bookmark: least-cost-path-analysis][bookmark: _Toc165644525]Least cost path analysis
Least cost path analysis is a technique which looks at the least “expensive” way to get from one location to another. The cost is not necessarily financial, it can be time, fuel, damage to the environment and many other examples.
We will be using raster layers to carry out the analysis. Examples of this form of analysis include:
· Planning the creation of a wildlife corridor.
· Planning the route of a new road or a pipeline from one location to another.
The vector equivalent is network analysis. This tends to be used for routing vehicles on roads or rails, which are existing networks. Examples include working out the most economic route for delivery van to take to make multiple deliveries.
[bookmark: setting-the-criteria]Setting the criteria
You have been asked to produce a map for the local Wildlife Trust, looking at how wildlife moves around the study area. They wish to establish new nature reserves in areas which will improve wildlife corridors and have asked you to suggest the most cost-effective pathways in which to locate the reserves.
For this section you will be using the same area as the previous part of the chapter - Otley and the area to the north. You will be able to use some of the same data and should have downloaded the rest at the start of the chapter.
If we were doing this properly the criteria may well be different, and more tailored to certain species, e.g. red squirrels, or curlew, but this is an exercise designed to give you the experience so we will work with the following criteria:
· Land cover - for example, woodland is ideal for wildlife, but urban areas may well not be.
· Water areas - for some wildlife, rivers and lakes will be barriers that they will be unable to cross.
· Altitude - whilst the range of altitude is not great in this area, there are upland areas which are not conducive to many species so we will consider higher altitudes as having “greater cost”.
· Distance - this is naturally included in the calculations, so we don’t need to include extra data for this.
[bookmark: preparing-the-data-for-each-criteria]Preparing the data for each criteria
As with multi-criteria analysis the data needs to be normalised to the same scale, usually 0-1, so that when we create a “cost surface” we can weight each factor.
You should already have downloaded all the data below at the beginning of the chapter.
Start a new blank map in QGIS and add the following layers
1. The StudyArea layer from the DecisionMaking GeoPackage - start by adding this to a new, blank map. This should set the CRS to epsg:27700.
1. Use a background layer, either from XYZ Tiles, or by downloading one from Digimap.
1. The StartPoint and EndPoints layers from the DecisionMaking GeoPackage.
1. The clipped DTM layer that you created earlier.
1. The SurfaceWater layer from the OS Open Map Local vector dataset - you should have saved this to a GeoPackage and restricted the extent to that of the study area.
1. The original vector Land Cover 2021 data that you downloaded.
Don’t forget to save your map.
Once again we need to “normalise” the data so that each dataset has values on a scale of 0-1. This time the values indicate cost, so a value of 0 is “best” or cheapest, and a value of 1 is “worst” or most expensive.
We need to create a cost surface, which is a single raster layer that indicates the cost of traversing each pixel. To do this we normalise the data for our criteria and then add each of the layers together, weighting them if required.
Once we have a cost surface it is possible to create a least-cost path which takes the cheapest route from a start point to single or multiple end points.
[bookmark: land-cover-data]Land cover data
For multi-criteria analysis we prepared the data by reclassifying the land cover. We need to reclassify the data again, but this time with different categories.
[bookmark: preparing-the-classification]Preparing the classification
To convert the land cover classes to a cost value we need to decide how to class them numerically from 0 (“cheapest”) to 1 (most “expensive”) and you can see my suggested classification in the table below. You are welcome to decide on your own classification!
	_mode
	description
	reclass

	1
	Deciduous woodland
	0

	2
	Coniferous woodland
	0

	3
	Arable
	0.3

	4
	Improved grassland
	0.3

	5
	Neutral grassland
	0.7

	6
	Calcareous grassland
	0.2

	7
	Acid grassland
	0.7

	8
	Fen
	1

	9
	Heather
	1

	10
	Heather grassland
	1

	11
	Bog
	0.8

	12
	Inland rock
	1

	13
	Saltwater
	1

	14
	Freshwater
	1

	15
	Supralittoral rock
	1

	16
	Supralittoral sediment
	1

	17
	Littoral rock
	1

	18
	Littoral sediment
	1

	19
	Saltmarsh
	1

	20
	Urban
	1

	21
	Suburban
	0.3


Now go to the previous instructions and carry out the reclassification to end up with a classified raster.
The identify tool seems to be more reliable for checking your rasterized classes than the styling does, so it’s worth trying that to check your result.
[image: images/decision/ReclassLandCoverRaster_small.png]
The reclassified land cover data which has now been rasterised. The classes are shown as greyscale from 0 - black - to 1 - white.
[bookmark: the-surface-water-data]The surface water data
At the moment this is a vector layer showing lakes, reservoirs and the larger rivers and we will treat these as barriers to the wildlife corridors. We will assume that the smaller streams do not constitute an obstacle.
We need to rasterize the water bodies so that they have a value of 1 - for high cost, and the surrounding areas have a value of 0, for low cost.
· From the Processing toolbox open Rasterize (vector to raster)
· The Input Layer is the SurfaceWater layer
· Under A fixed value to burn enter a value of 1
· The Output raster size units are Georeferenced units
· Width and Height should be set to 5 (the same as the DTM resolution)
· Set Output extent to the same as the StudyArea layer
· Under Assign a specified nodata value to output bands delete the 0.000 so that the field reads Not set - we don’t want a nodata value.
· As usual set where to save the output and what to call it
· Then click Run.
[image: images/decision/RasterizeWater_small.png]
Rasterizing the SurfaceWater layer so that the surface water areas have a value of 1, and the rest a value of 0.
The output should show the water areas in white and the rest in black. Use the Identify tool to check that the lakes etc have a value of 1 and the rest of the layer a value of 0.
[image: images/decision/RasterizedWater_small.png]
The rasterized SurfaceWater area layer.
[bookmark: the-dtm-layer]The DTM layer
We’ll use the Terrain 5 DTM layer for the altitude and normalise it so that the highest land has a value of 1 for the highest cost, and the lowest a value of 0 for the lowest cost.
For the multi-criteria analysis we used the Fuzzify raster (linear membership) tool to normalise the DTM, and we’ll use it again this time. But instead of adding the lowest value to the High fuzzy membership setting, and the highest to the Low fuzzy membership, this time the original layer has values which change in the correct direction.
· So add the lowest value to the Low fuzzy membership bound
· and the highest value to the High fuzzy membership bound
You should end up with an output layer that looks very similar to the input layer, but which only has values from 0 to 1.
Once again use the Identify tool to check that this is the case.
[bookmark: combining-the-layers-as-a-cost-surface]Combining the layers as a cost surface
When you’ve normalised all the data layers you need to combine them into a Cost surface. This is a raster layer in which each pixel or cell contains the “cost” of moving across it. This cost is obtained by adding all the criteria layers together and saving the output. During this process we can weight the criteria if required, rather as we did in the multi-criteria analysis. The process is indeed very similar and we will use the raster calculator again.
You can repeat the step of determining the weights for each criteria via the AHP tool, if you wish. Or use a rough figure for the weighting.
This is another point at which you need to use your experience as a scientist, or the priorities of the organisation for whom you are making the map, to work out what the weighting should be.
I have used the following to indicate the importance of the cost for each layer, remembering that the higher the value, the higher the cost, so the less suitable that path will be.
· Land cover - a weighting of 40
· Surface water areas - a weighting of 40
· Altitude - a weighting of 20
You can experiment with these weightings, if you wish, by producing several versions of the cost surface. Just keep a note of your input values for each output.
· Open the Raster Calculator
· Set the output details as usual
· Enter the following expression into the Expression box at the bottom of the calculator, double-clicking on the layers in the top right to make sure that you enter them correctly.
· Update the weightings that are used to multiply the normalised layers with the weightings that you have decided to use.
("LandCover_R@1" * 40) + ("WaterArea_R@1" * 40) + ("DTM_norm_lcp@1" * 20)
[image: images/decision/RasterCalcLCPSurface_small.png]
Combining and weighting the data for the cost surface in the raster calculator.
The output will vary depending on the weighting of your criteria, but will be a greyscale layer. See the example below.
[image: images/decision/CostSurface_small.png]
The resulting cost surface. Your cost surface probably won’t be identical to this one.
[bookmark: the-least-cost-path-tool]The Least cost path tool
Once you have a cost surface you are in a position to work out the cost of travelling from one location to another.
[bookmark: start-and-end-locations]Start and end locations
To be able to do this you need to have two point feature classes, one containing the starting point, and the other either single or multiple end points. These have been provided for you in the DecisionMaking.gpkg GeoPackage and should be added to your map now if they haven’t been already.
· The StartPoint feature class contains a single point in the woodland in the centre of the map.
· The EndPoints layer contains four points located in areas of woodland around the edges of the study area.
[bookmark: the-cost-distance-analysis-plugin]The Cost distance analysis plugin
There are GRASS and SAGA tools available in the Processing Toolbox that will do various cost distance tasks, but the simplest to use can be installed as a plugin.
[image: images/svg/videocam-black-24dp.png] Using the Cost distance analysis plugin to calculate least cost paths in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Go to the Plugin manager and install the Least-Cost Path plugin.
Once it is installed you will have a new entry in the Processing toolbox. Search for Least Cost Path to find it.
· Open the Least Cost Path tool from the Processing toolbox
· The Cost raster layer is the cost raster surface that you created in the raster calculator
· Under Cost raster band select Band (Gray), which should be the only choice available.
· The Start-point layer is StartPoint
· The End-point(s) layer is EndPoints
· Browse to where you want to save the output and save it as a GeoPackage layer.
· Run the tool
[image: images/decision/LeastCostPath_small.png]
Filling in the form to generate a least cost path.
[image: images/svg/warning-black-24dp.png] Warning
This tool can take a long time to run and can give a “not responding” message. Just let it run, don’t try and stop it, or click on anything. Hopefully it will resolve itself after a while.
On my computer, which is pretty good, it took 4 minutes to run. There are a lot of calculations going on behind the scenes.
When the tool finishes the output should be a vector layer with lines running from the start point to each of the end points.
If you look at the attribute table you should be able to see a value next to each line. This is the cost of traversing the raster along that line.
I have labelled the end of each line with the fid, so it is possible to match the line to the cost value.
[image: images/decision/CostPaths_small.png]
The resulting least cost paths from the start point to each of the end points. Also showing the cost values in the attribute table - the lines are labelled with the fid.
[image: images/svg/create-black-24dp.png] Experimenting with different cost surfaces
Feel free to try creating a cost surface with different weightings and run the least cost path tool again to see what the difference is. You could also create more points in the end point layer - though bear in mind that the tool will take longer to run if there are more end points.
[bookmark: the-final-least-cost-path-map]The final least cost path map
Try making a layout to show your least cost paths and the land cover layer. Don’t forget to add a key to the layers that you’ve displayed, and also include the final costs of each path.
When you have created a layout export it to either an image or pdf.
[image: images/decision/OtleyLCP_small.png]
Example of final map showing the land cover and the least cost paths across the landscape. How your paths cross the map will depend on the decisions you made about weighting and values.
[bookmark: Xd7371094be6da814dac4b79845817c0887cbe18][bookmark: _Toc165644526]Further information and suggested reading for elevation
Many of the books in the reading list[footnoteRef:4] have general information about elevation data. Suggestions include the following: [4:  The reading list is available in Minerva and from the library (search for the number of this module).] 

· Chapter 7, Analytical modelling in GIS in Heywood, I., Cornelius, S. and Carver, S. (2011), In particular pp.244 onwards cover “Modelling the decision-making process”.
· Section 15.4 in Longley, P.A. et al (2015) covers Multicriteria methods (p. 352 - 354). It would also be worth having a look at section 15.5 - Accuracy and validity: Testing the model (p.354 - 356.
For technical information that refers specifically to QGIS try the following:
· QGIS Tutorials and Tips - this is a series of tutorials which cover some of the techniques you’ve been using in these exercises. It’s worth browsing the list, but particularly relevant to this chapter would be Multi Criteria Overlay Analysis.
[bookmark: making-repetition-more-efficient][bookmark: _Toc165644527]Making repetition more efficient
Last Modified: 18 Apr 24, 16:11:06
The background to the techniques for making repetition more efficient will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes][bookmark: _Toc165644528]Learning outcomes
When you have completed this section of the workbook you should be able to
· demonstrate techniques to use QGIS to carry out repetitive workflows more efficiently
· explain the use of the model builder in QGIS
· analyse a task and build a model to produce the required output
· use batch processing to run a model multiple times to produce multiple outputs
[bookmark: introduction-2][bookmark: _Toc165644529]Introduction
In the chapter on elevation models, you saw how to carry out batch processing to repeat the use of tools multiple times to produce maps of which summits were visible from particular viewpoints in the Lake District. This did make processing more efficient, but you still had to run each tool individually. In this chapter we’ll look at other ways to make repetitive tasks more efficient by using the graphical modeler in QGIS. We’ll also combine a graphical model with batch processing and then have a quick look at how python can be used within QGIS to extend efficiency even further.
The graphical modeler allows you to drag and drop input and processing tools (called algorithms in this context) onto a “canvas” and link them together in the order in which they should run. So you can run multiple tools in one pass using the output from one as input to another.
Once you have created a model you run it in exactly the same way that you run any other tool from the processing toolbox. When you run the tool you will get a chance to input the data from your map, or any other variables that you’ve set up, and to give your output names. The form that you need to fill in will look very familiar but have a few key differences.
[bookmark: data-for-the-repetition-exercises][bookmark: _Toc165644530]Data for the repetition exercises
We will use the Lake District Hills data again for this chapter. I have uploaded a “clean” copy of the project to Minerva as Repetition_Q.zip.
· Download Repetition_Q.zip from Minerva and unzip it to your GIS folder.
· Open LakeDistrict.qgz in QGIS and have a look at the contents.
· All the layers are stored in the geopackage that is also in the folder, so if QGIS opens and gives the error about not being able to find layers, you should be able to tell the program to look in LakeDistrict.gpkg.
[image: images/repetition/InitialProject_small.png]
The initial view of the Lake District map showing the layers that you should be able to see.
Most of the layers should look familiar from the previous exercises, but I’ve also included a layer called Viewpoint which contains a small selection of summits to use as viewpoints for processing.
[bookmark: planning-your-graphical-model][bookmark: _Toc165644531]Planning your graphical model
Before you jump in and start creating your model you should begin by planning what you want it to do. One advantage of building a model is that you can run it and then easily go back and alter it before running it again, but if you plan in advance it makes it much quicker to get the right result.
It is a good idea to start with a simple, basic model and make sure that works first before adding more functionality. Once you have that running you can then look at how to streamline it further or what other algorithms or parameters you can add.
When you look at the process you are automating think about what you really need to include, and what is best left out, maybe because it only needs to run once. For example, we’ll be creating a model to run a viewshed and select visible summits. This is based on elevation data which consists of merged tiles. You could merge the tiles as part of the model, but actually that’s a task that only needs to happen once and then the same output is used to run the model each time. If you include merging the elevation data in your model you’d actually be processing the data more often than you need to. So in this case it makes more sense to process the elevation data once before you start, then use the merged elevation data as the input to your model.
As usual in GIS (or any research) start by thinking about what question you are trying to answer. In this case the question is:
How many summits from within the Lake District National Park can be seen from a selection of viewpoints, also located within the National Park?
Once you know the question you can think about the data that you need.
[image: images/svg/help_outline-black-24dp.png] What data do you need to start with?
I’ve provided you with the data for this exercise, but usually you’ll need to think this through for yourself.
The chapter on elevation models 2 has already shown you the process that you want to automate in this model to answer that question. This is good because it shows that you know how to produce the correct result manually first. But the next question before you start to build your graphical model needs to be:
[image: images/svg/help_outline-black-24dp.png] What processes or tools do you need to run on that data to produce the required outputs?
Have a look at the viewshed analysis exercises and make a list of the data and processes that you need.
In the rest of this chapter, I’ll take you through the processes step-by-step, but usually you’ll need to make a list for yourself. Maybe something like a quickly scribbled version of the diagram below would be useful (I’ve typed this out for clarity, but usually a quick scribble is absolutely fine).
[image: images/repetition/ViewshedProcess.png]
Planning a visual model to find visible summits from multiple viewpoints.
[bookmark: Xd3096f8b21d787df1cfe8a50faab8f605b3dd13][bookmark: _Toc165644532]Building a graphical model in the Model designer
[image: images/svg/videocam-black-24dp.png] Creating a new graphical model in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· From the data that you downloaded for this chapter make sure that LakeDistrict.qgz is open and the data is visible in the map.
To open the QGIS graphical modeler Model designer go to:
· Processing > Graphical modeler... or the keyboard shortcut Ctrl + Alt + G
The window that opens should look something like the image below, though you may have slightly different panels open by default.
[image: images/repetition/ModelDesigner_small.png]
The model designer when you first open it.
You’ll build your model in the blank area on the right using items from the panels on the left. The two panels you’ll use most are the Inputs and the Algorithms.
The panels include a list of Inputs, also referred to as Parameters. This covers a wide variety of types of data from plain text to vector feature classes. I’ll show you how to use a few of these in this chapter, but if you are building your own models you can try out anything that looks as if it might be useful.
The tab for Algorithms contains the list of processing tools that you can use within a model. You should be able to find any of the tools we’ve already used in the exercises.
Remember that in the model designer, processing tools are called algorithms and that’s how I’ll usually refer to them in this chapter.
[bookmark: saving-a-new-model]Saving a new model
As usual it is a good idea to keep saving your work.
By default, graphical models are stored in a default location on your computer. If you save them to the default then QGIS will pick them up automatically and list them in the Processing Toolbox. It is also possible to save them to a location that you choose. If you do this then you will need to navigate to your model in the Browser Panel each time but if you are working on a University computer this is a more reliable way to make sure you don’t lose your model!
It is also possible to save your models to the project. This makes it harder to reuse and share them, but usually makes it easier to keep track of them while you are working on them on any system, so this is what we will do here.
[bookmark: Xabe1fac2414c21f2fa28a41b4bbd334e8711ba0]Saving a model to the project and opening it again
[image: images/svg/videocam-black-24dp.png] Saving and reopening a graphical model to a project in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To save a model to your project:
· Find the Model Properties panel on the left of the model designer. You may need to click on the tab to bring it to the front.
· Enter a name for your model - in this case enter VisibleSummits.
· Enter a group name. This allows you to keep related models together. Enter Visibility as the group name.
[image: images/repetition/NamingModel_small.png]
Giving your model a name and group in the model properties.
· In the Model Designer menu go to Model > Save Model in Project.
· Alternatively, press on the button on the toolbar of the Model Designer - as usual tool tips will work, look for Save model in project.
You should see a notification that Model was saved inside current project.
[image: images/svg/warning-black-24dp.png] Warning
You’ll need to use the same command each time you want to save the model to your project - i.e. Save Model in Project.
If you just click on Save, or use <Ctrl>-S, your model will be saved to the default location.
· Close the model now by clicking on the cross at the top right.
You won’t be able to see the model in the project in the browser panel, even if you refresh the browser.
To reopen your model:
· Open the Processing Toolbox - Processing > Toolbox.
· Look down the list of toolboxes and you should be able to see one for Project models.
· Click on the arrow to drop down the heading. You should see the Visibility subheading and within that should be your VisibleSummits model.
· To reopen the model right-click and select Edit model...
[image: images/repetition/OpenFromProject_small.png]
Opening a model from the Project Models in the Processing Toolbox. Right-click to select Edit, rather than double-click.
If you double-click on the model in the toolbox, it will run rather than open for editing.
[image: images/svg/create-black-24dp.png] Starting to edit your model
Make sure you have your model open in the Model Designer ready to start building it with the instructions in the next section.
[bookmark: adding-input]Adding input
We’ll start by adding the data that is required as input to our model. Nothing else will work until we’ve done this!
[image: images/svg/videocam-black-24dp.png] Adding input to a graphical model in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
The first layer to add is the elevation data.
Remember in this section that you are not actually adding the data from your map at this stage. You’re adding a “place holder” that you will add the data to when you run the model.
· Go to the Inputs panel on the left of the model designer.
· The required elevation data will be a raster file so scroll down the list of choices and select Raster Layer.
[image: images/repetition/InputsRaster_small.png]
Selecting Raster Layer as the first input.
· Double-click on Raster Layer to open the parameter definition box
· Under Description add the text that you want to see when filling in the tool dialog - so in this case enter Elevation data.
· This input is required to run the tool so leave Mandatory ticked.
· Don’t tick Advanced.
· Click OK to add the input to the model. It should look something like the image below.
[image: images/repetition/InputHeight_small.png]
The first item in your visual model - the elevation data input field.
The second item to add is the input for the viewpoint. This isn’t going to be a layer in your map. When running the model you will need to click on the map to enter the location for the viewpoint.
· From the Inputs panel double-click on Point to open the Point Parameter Definition panel.
· Under description type Viewpoint.
· Leave the Default value as Point as 'x,y'
· Leave Mandatory ticked, and Advanced unticked.
· Click OK to add the input to your model.
You will also need the full list of Lake District summits to get the required result.
· From the Inputs panel double-click on Vector Layer to open the Vector Layer Parameter Definition panel.
· Under description type Summits.
· Under Geometry type select Point so that only point feature classes can be added. Restricting parameters where possible can make errors less likely when the model is run.
· Leave Mandatory ticked, and Advanced unticked.
· Click OK to add the input to your model.
At this stage your model designer should contain three input layers as shown below.
[image: images/repetition/InputData_small.png]
The three input layers for your model.
If you want to edit any of the input you can click on the three dots button on each one. To delete any of the boxes just click on the cross.
It’s worth having a look at the input types available to you. Sometimes it’s not clear which one will do what you want it to do. Just experiment. Add possible input types to your model and see what happens.
[bookmark: adding-algorithms]Adding algorithms
Remember that, in model building terms, algorithms are the processing tools that you have used before.
[image: images/svg/videocam-black-24dp.png] Adding algorithms to a graphical model in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: adding-the-r.viewshed-algorithm]Adding the r.viewshed algorithm
The first processing tool, or algorithm, on our list is the viewshed tool. The tool which works out which areas are visible from a particular viewpoint and which aren’t.
[image: images/svg/warning-black-24dp.png] If you have problems with GRASS tools
If you have had problems with GRASS tools such as r.viewshed and v.surf.rst, then feel free to use the GDAL Viewshed tool instead of r.viewshed. It isn’t as effective, but will work for this exercise. Some of the options are different, but input your DTM, add the Observer Location as you would usually add a viewpoint, and increase the Maximum distance from observer... to something like 20000 metres. You should be able to Polygonize the result as usual.
To add the r.viewshed algorithm:
· On the left of the window click on the Algorithms tab to go to the full list. If you browse the list you’ll see that it is arranged in the same way as the processing toolbox that you are familiar with.
· Note that there is a search box at the top of the panel. Use this now to search for the first tool by typing viewshed.
[image: images/repetition/AlgorithmsSearch_small.png]
Searching for r.viewshed in the Algorithms tab.
· Double-click on the r.viewshed tool to open the dialog.
This will look familiar, but does include some new options specific to using the tools in a model.
This example makes use of the extra options available for adding input.
· Click on the button to the left of the Elevation field - the one with numbers on it. This will give you some new choices. Select Model input. Then you should be able to select one of your inputs from the dropdown box - make sure that you set this to Elevation data. Note that this may be set automatically. It just needs to look as it does in the figure below.
· Do the same with the Coordinate identifying the viewing position, this time selecting the Viewpoint input.
[image: images/repetition/ViewshedTool_small.png]
Setting up the r.viewshed tool.
We’ll leave the other fields as they are for now, but remember that we selected a setting from the Advanced section of the viewshed tool before.
· Click on the Show advanced parameters button at the top of the dialog.
· Scroll down and find the Output format is invisible = 0, visible = 1 setting. Change this to Yes.
The output from this tool is required by the next tool in the model, but it isn’t necessary to display it on your map, so you don’t have to save it to your computer. Instead it can just be used directly in the next tool.
· Under Intervisibility check that the button on the left is set to Model Output (the icon is a green arrow pointing right). The box should say [Enter name if this is a final result]. As it isn’t you don’t need to enter anything.
· Click OK to add the algorithm to your model.
[image: images/repetition/Model01_small.png]
The model so far. Note how the input is now linked to the first algorithm.
The box that is added to your map should show that it is a GRASS tool (icon on the left of the box) and that the Elevation data and Viewpoint input is linked to the algorithm.
[bookmark: testing-the-model-so-far]Testing the model so far
It is an extremely good idea to run your model at every stage of building it. This gives you a chance to sort out any problems while you can still remember what you have just done, and is essential if you are adding a lot of tools or data.
[image: images/svg/videocam-black-24dp.png] Running a graphical model in QGIS to test that it works.
This video clip can be found in the module area of Minerva or in the full list of video clips.
At this stage there is no output, but it is still a good idea to keep testing your model to make sure that there are no errors.
· Save the model by going to Save Model in Project.
· To run the model you can either press F5 or use the green arrow button on the Model Designer toolbar. Do this now.
· Running the model should open a dialog in which you need to enter the layers from your map.
· Under Elevation data select Terrain50DTM
· Under Summits select LakeDistrictHills
· Under Viewpoint you need to enter the coordinates. With the model designer open QGIS won’t let you click on the map, so instead of clicking on the three dots button enter the following coordinates:
329823,489995
[image: images/repetition/Testing01_small.png]
Filling in your layers to test the model so far.
· Click Run to run the tool.
You should see the Log panel and the usual messages going past. It may take a while to run - remember it is the r.viewshed tool that is running.
[image: images/repetition/Testing01a_small.png]
The end of the Log from a successful run.
We’ve selected not to save or display the output so the viewshed won’t appear, but check the Log to see that there were no problems with what you have entered so far. It should say something like
OK. Execution took 5.235 s (1 outputs).
Model processed OK. Executed 1 algorithms total in 5.373 s.
Your times will vary.
[bookmark: adding-the-polygonize-algorithm]Adding the Polygonize algorithm
Once you have generated the viewshed the next tool on our list is Polygonize to convert the raster output to a vector polygon layer.
· In the Algorithms tab search for Polygonize
· The tool you need is Polygonize (raster to vector) so double-click to open that from the GDAL toolbox.
· Again the dialog should look familiar, but with the number buttons on the left of the fields.
[image: images/repetition/PolygonizeTool_small.png]
The Polygonize tool dialog showing the Input layer from the r.viewshed tool.
· Click on the number button to the left of the Input layer field.
· This time we’re taking the input from the previous tool so select Algorithm output. Set the dropdown to "Intervisibility" from algorithm "r.viewshed"
· Under Name of the field to create you can enter something a bit more informative than the default DN, for example, enter Visible.
· Under Use 8-connectedness select Yes
· Once again the output from this tool won’t need to be displayed on your map so under Vectorized check that Model output is set and that it says [Enter name if this is a final result].
· Click OK to add the algorithm to your model.
[image: images/repetition/Model02_small.png]
The model with the Polygonize algorithm added. This should link from the r.viewshed tool.
[bookmark: testing-the-model-again]Testing the model again
At this stage there still won’t be any output, but again it is a good idea to keep testing your model to make sure that there are no errors.
The input form will look the same as it did before and you need to fill it in in the same way.
· Save the model by using Save model in project.
· To run the model you can either press F5 or use the green arrow button on the toolbar. Do this now.
· Running the model should open a dialog in which you need to enter the layers from your map.
· Under Elevation data select Terrain50DTM
· Under Summits select LakeDistrictHills
· Under Viewpoint you need to enter the coordinates, though they may already be there from the previous test. With the model designer open QGIS won’t let you click on the map, so instead of clicking on the three dots button enter the following coordinates:
329823,489995
[image: images/repetition/Testing01_small.png]
Filling in your layers to test the model so far.
This time the Log should show that you have executed 2 algorithms rather than 1, but should still say that the Model processed OK.
[bookmark: adding-the-fix-geometries-algorithm]Adding the Fix geometries algorithm
If you remember from when you ran the viewshed tool before and then polygonized the output, it wasn’t possible to feed the result directly into Extract by attribute as it gave an error. To fix this we needed to run Fix geometries. So that is the next algorithm to add to your model.
· Search the Algorithms tab for Fix Geometries and double-click on it.
· You can make the Description at the top a bit more informative, e.g. Fix geometry of visibility vector output.
· Click on the number button to the left of the Input layer box and select Algorithm output as we’re fixing the output from the Polygonize tool.
· In the dropdown select "Vectorized" from algorithm "Polygonize (raster to vector)"
· Once again the output from this tool won’t need to be displayed on your map so under Fixed geometries check that Model output is set and that it says [Enter name if this is a final result].
· Click OK to add the algorithm to your model.
[image: images/repetition/FixGeometriesTool_small.png]
Filling in the Fix geometries algorithm with the output from the Polygonize algorithm.
Your model should look something like the image below at this stage. You can rearrange the boxes if you need to, to make sure that you can still see them all on the page.
[image: images/repetition/Model03_small.png]
The model with the Fix geometries tool added. It should be linked from the Polygonize tool.
[image: images/svg/create-black-24dp.png] Save and test your model.
Once again save and test your model in the same way as before.
Check the log to make sure it ran successfully and that there are now 3 algorithms.
[bookmark: adding-extract-by-attribute-algorithm]Adding Extract by attribute algorithm
Looking at the diagram above, the next step is to extract all the areas that are visible. In this case that means that they have a value of 1 in the Visible field.
As we know the attribute that we want to save we can use the Extract by attribute algorithm.
· Find the Extract by attribute algorithm in the Algorithms panel.
· Change the Description so that it gives a clearer explanation of what this step is doing, e.g. Save all areas that are visible from the viewpoint.
· The Input layer is output from the Fix geometries algorithm
· The Selection attribute is the attribute from the output of the Fix geometries algoritm, in this case back in the Polygonize tool we named this as Visible, so type that into the box.
· The Operator is =
· The Value is 1 (remember, 0 = invisible, 1 = visible).
· This time we do want to save the output so under Extracted (attribute) type a prompt for the output name, e.g. Visible areas. This won’t be the final file name, it is just a prompt for the form that you fill in when you run the model.
· Once you’ve filled in the form click OK to add the algorithm to your model.
[image: images/repetition/ExtractByAttributeTool_small.png]
Filling in the form for Extract by attribute.
By this stage your model should look something like the image below. Note that the final algorithm now has output shown - the green box with the arrow icon on the left.
[image: images/repetition/Model04_small.png]
The model with the Extract by attribute algorithm added - note the output which will be available to show on a map.
[image: images/svg/create-black-24dp.png] Save and test your model.
Once again save and test your model in the same way as before.
This time you will also have an option to save the output. For now [Create temporary layer], but also tick to Open output file after running algorithm so that you can check the output.
Check the log to make sure it ran successfully and that there are now 4 algorithms.
Check the layer on the map to see whether it looks as you would expect it to. This will be the visible areas from a point somewhere in the south of the National Park. It should look something like the map below - the orange areas are the visible areas.
[image: images/repetition/Testing04Output_small.png]
The output of the model at this stage. Showing the visible areas.
[bookmark: adding-the-extract-by-location-algorithm]Adding the Extract by location algorithm
There is one final step for the planned model. We need to extract the summits which are visible from the viewpoint. To do this we can use the Extract by location algorithm.
· Find the Extract by location algorithm in the Algorithms panel.
· Change the Description so that it gives a clearer explanation of what this step is doing, e.g. Extract visible summits.
· Extract features from - use the Model input from Summits
· For Where the features click on the three dots button at the end of the line and check that intersect is ticked.
· By comparing to the features from - use the Algorithm output from the dropdown which says "Extracted (attribute)" from algorithm "Save visible areas".
· Again, you’ll want to keep this output so under Extracted (location) type a prompt for the output name, e.g. Visible summits.
· Click OK to add the algorithm to your model.
[image: images/repetition/ExtractByLocationTool_small.png]
Filling in the form for Extract by Location to select the visible summits.
By this stage your model should look something like the image below. Note that there are now two algorithms with output shown - the green boxes with the arrow icon on the left.
[image: images/repetition/Model05_small.png]
The model with the Extract by Location algorithm and the output for visible summits.
[image: images/svg/create-black-24dp.png] Save and test your model.
Once again save and test your model in the same way as before.
This time you will also have an option to save two outputs. For now [Create temporary layer], but also tick to Open output file after running algorithm so that you can check the output.
Check the log to make sure it ran successfully and that there are now 5 algorithms.
Check the output layers on the map to see whether they look as you would expect them to. These will be the visible areas from a point somewhere in the south of the National Park, and the summits which intersect with those areas. It should look something like the map below - the orange areas are the visible areas and the blue dots are the visible summits.
[image: images/svg/videocam-black-24dp.png] Running a graphical model in QGIS to test that it works.
This video clip can be found in the module area of Minerva or in the full list of video clips.
[image: images/repetition/Testing05Output_small.png]
The model output showing visible areas and the summits within those areas.
[bookmark: X24777ed878478b5d30c6c4be640934208dbbbce]Adding an input field for viewpoint names
If you want to use batch processing to run the model multiple times (which we will do in a moment) there is another input that you can add which could make running it more efficient.
If you add a field to contain viewpoint names then you can use that to “Autofill” the output names when you use the model in batch processing mode.
· Edit your model again and from the Inputs tab add a String input type. This will allow you to type text into the form.
· Under description call it Viewpoint name
· You don’t need to add a Default value.
· Leave Multiline input unticked.
· Untick Mandatory - you probably won’t want to add this when you are running the model a single time, it will only be useful for batch processing.
· Click OK to add the input to your model.
[image: images/repetition/StringParameter_small.png]
Adding a parameter for viewpoint names - useful if using batch processing.
[image: images/repetition/Model06_small.png]
The final model, including a field for Viewpoint name.
The input for Viewpoint name won’t be linked to anything. This is fine.
[bookmark: final-test-of-your-model]Final test of your model
Run your model to test it for the final time. Try adding a Viewpoint name to check that it doesn’t cause any problems, but it won’t be used by the model on this run anyway.
If everything is running correctly then your model is complete and ready to use for multiple outputs.
· Save your model and close it
· Then go straight to the section on Rearranging your model elements.
If there are problems with your model then the testing at each individual stage should give you some idea of where the problems appeared.
· Go back and try following the instructions again.
· If that still doesn’t work then have a look at the things to check in the Trouble-shooting graphical models section below.
[bookmark: rearranging-your-model-elements][bookmark: _Toc165644533]Rearranging your model elements
You can rearrange the elements on your model simply by dragging and dropping. This can be useful if you are building a complex model with lots of input and processes.
It can also help to “tidy up” the elements if you are going to export your model for inclusion in another document.
It is also possible to resize each of the elements if you need to, for example, if the name of one is too long to fit in the box. You can see this with the Polygonize (raster to vector) algorithm on my model. Resize by clicking on the element, then use the little “handles” to drag the box to the correct size.
[bookmark: trouble-shooting-graphical-models][bookmark: _Toc165644534]Trouble-shooting graphical models
When programming computers it is very rare for everything to work correctly the first time. If you need to go back and check everything, don’t worry - you’re in good company.
[bookmark: things-to-check]Things to check
· Looking at the model in the canvas, do the lines between the data and the algorithms link up correctly?
· Check the input for each algorithm. Have you chosen the correct output from previous models? Have you forgotten to choose “Model input” where relevant?
· Are all the parameters for your algorithms correct? Check the logs for red text. Do you maybe need to set the GRASS processing extent or cell size to get the GRASS tools to work?
· Have you chosen to save the correct output and add it to your map?
[bookmark: running-the-final-model][bookmark: _Toc165644535]Running the final model
Make sure that you have the Lake District map open. If you still have the temporary layers from the last time you ran your model then remove them from your map.
Your model should not be open for editing. If it is you won’t be able to click on the map.
Your map should contain a layer called Viewpoint. This contains ten randomly selected Lake District summits to use as viewpoints when running your model. We could try running the model for all summits in the Lake District - but there are rather a lot of them!
· Zoom in on the point for Stickle Pike in the south-west of the Lake District so that you can add it as the viewpoint when you fill in the form for the tool
· Open your model to run it - either via the processing toolbox or the Browser. Don’t choose to edit your model, but instead run or execute.
· Fill in the form as you have done before, but this time clicking on Stickle Pike rather than typing the coordinates in
· Keep the output as [Create temporary layer] for now.
· Click on Run to generate the output.
[image: images/svg/help_outline-black-24dp.png] How many Lake District summits are visible from Stickle Pike?
By right-clicking on the visible summits in the Layers panel and selecting Show feature count, my result is 154. Is yours similar?
Don’t worry too much if it isn’t - on a second run my result was 53. The output of the viewshed depends very much on how accurate you were when you clicked on the point!
[bookmark: running-the-model-as-a-batch-process][bookmark: _Toc165644536]Running the model as a batch process
While being able to “chain” the processes together so that you only have to fill in one form rather than five does save some effort, you will still have to run your model ten times to get the answer for all the viewpoints.
It isn’t (yet) possible to “loop” within a graphical model in QGIS so that you can run it multiple times, but there is an alternative way of doing this, and you’ve already used it back in the elevation models chapter. It is of course batch processing. Because your model runs in the same way as any other tool, you also have the option of running it as a batch process.
[image: images/svg/videocam-black-24dp.png] Batch processing in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Remove the temporary layers from your map again.
· Open your model to run or execute it (not edit it) - either via the processing toolbox or the Browser.
· This time click on Run as Batch Process... at the bottom left of the dialog.
You may need to resize the window so that you can see more of the fields, but these should all look familiar.
· Click on the plus button at top left to add another nine rows - the final one should be number 11.
· Add the Elevation data by selecting the dropdown in the first row and choosing Terrain50DTM.
· Now click on Autofill... and Fill down
· Do the same for Summits which needs to be set to LakeDistrictHills
· Viewpoint has to be added by clicking on the map, so click on the three dots button next to the first box and click on the point for Carrock Fell on the map.
· So that you remember which viewpoint this is, also type CarrockFell into the first box under Viewpoint name. Note that there are no spaces - this will be used in a file name so be careful how you enter it.
· Repeat the previous two actions for each of the ten viewpoints. It doesn’t matter which order you enter them.
· Now move onto the Visible areas field, which is the output. Click on the three dots button on the right of the box and navigate to a folder where you want to store the output. It might be a good idea to create a new folder called Output so you don’t get muddled - you’ll be creating 20 new files.
· Type a file name - try VisibleAreas, and check that you’re creating a new GPKG file. Then click on Save
· The Autofill settings should open. This is where the Viewpoint name field becomes useful. Set Autofill mode to Fill with parameter values and next to Parameter to use select Viewpoint name.
· Click on OK
[image: images/repetition/AutofillSettings_small.png]
Using the viewpoint name to autoname the output.
You should see the Visible Areas fields fill with the file name that you entered, but also the Viewpoint name. This prevents the output from overwriting on each run, but also makes filling in the form to generate multiple output easier.
· Repeat the last three steps to autofill the Visible summits field in the same way.
· Put a tick next to Load layers on completion
The form should look something like the version below. Don’t click on Run yet - we’re going to save the parameters that you’ve filled in.
[image: images/repetition/BatchProcessing01_small.png]
The completed batch processing form with the output names autofilled.
[bookmark: saving-your-batch-processing-parameters]Saving your batch processing parameters
You’ve spent a bit of time filling in the parameters for the tools. It won’t save you much time if you have to put everything in again next time you run the tool. There aren’t many parameters in this model, but in some you could have many more.
[image: images/svg/videocam-black-24dp.png] Saving and reusing batch processing parameters in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To save the parameters that you’ve entered:
· Click on the Save icon at the top left of the batch processing window
· Navigate to your project folder
· Give the saved file a name such as VisibleSummitsCompleted
· The Save as type: will be JSON files (*.json)
· Click on Save
The output is a type of text file. If you open it in a text editor such as Notepad++ (Windows) or TextEdit (Mac) you can see the contents, though it does look rather confusing!
[image: images/repetition/JSONfile_small.png]
Part of the saved JSON file containing the settings for your batch processing. This is open in Notepad++.
Once you’ve saved a set of parameters you can reopen them by clicking on the folder icon at the top left of the batch processing window.
[bookmark: X70ee01bc156a9ce358a95f70a6aa94f0bef7e88]Running the model in batch processing mode
Now you can run the model
· Click on Run
This could take a while - remember you’re running five algorithms ten times over. Just be patient and leave it to run!
With luck your model will run straight through and you’ll have twenty new layers added to your map.
Have a look at your map. It should look something like the image below, though your colours will probably be different.
[image: images/repetition/ModelOutputBatch_small.png]
The output from batch processing - twenty new layers styled with random colours.
The Layers panel should show the new layers have been saved with the name of the viewpoint.
Once again you should be able to right-click on the VisibleSummits layers and select Show feature count to see totals.
[image: images/svg/help_outline-black-24dp.png] Which viewpoint has the highest number of visible summits?
On my map it is Fairfield which can apparently see 359 summits. Maybe because it is in the centre of the national park.
[bookmark: going-further-with-a-graphical-model][bookmark: _Toc165644537]Going further with a graphical model
Once you have the basic model working and producing the output that you need, you can go back to it and add any extras that have struck you while you were working on it. Sometimes you’ll run a model and think “I wonder whether I can do something else here to make it more efficient?”
If you have a working model and want to make alterations to it, first save a new copy of your model. This means that if your alteration doesn’t work you can go back to the previous version.
· Go to Model > Save Model As... and give the model a new name. You can just add a number to the end of the existing file name.
· It’s also a good idea to go back to the Model Properties and change the Name of the model in the same way.
Below I give you some suggestions but feel free to come up with your own ideas and experiment.
[bookmark: adding-further-parameters]Adding further parameters
Adding further parameters can make the model more flexible, though too many can make it confusing to run.
The r.viewshed tool has parameters for Viewing elevation above ground and Offset for target elevation above the ground. You could use additional Input parameters to set these when you run the model.
· Under Description put the name of the parameter, e.g. Viewing elevation above ground
· Look for Number in the list of Input types and set the Properties to Float to allow decimal points.
· Under Default value you can enter a default value of 1.75.
· This won’t need to be Mandatory so you can untick that.
· If you tick Advanced the parameter will be under the Advanced subheading when you run your model. Tick that now to see what effect it has.
· You can then choose Model Input as the input in the algorithm.
[image: images/repetition/ViewshedAdditionalParameters_small.png]
Setting viewing and target elevations via model input.
[image: images/svg/help_outline-black-24dp.png] Are there other parameters in this or other algorithms that you could usefully set like this?
[bookmark: X089b9c4003a7579d55e7a55d5a9e0b5a31c3f78]Using the saved batch processing input to run the model again
Once you have made your changes you’ll want to run the model as a batch process again. Remember that you have the json file that you exported which contains the parameters that you used before.
Although you may have changed or added parameters, you can use that file to fill in some of the previous ones. This will probably still save you time.
[image: images/svg/videocam-black-24dp.png] Saving and reusing batch processing parameters in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
If you set some of the parameters as Advanced you’ll need to click on the settings button at the top left of the batch processing form to see them.
· Close the Model Designer
· Delete the data from your previous run of the model
· Open the model to run or execute it
· Click to Run as a batch process...
· Click on the folder button at the top left of the window and select the .json file that you saved previously.
The Batch Processing dialog should fill with the parameters that match your previous version. You will still need to fill any new parameters that you’ve set up. Remember to click on the settings button to see the advanced parameters and remember that you can use Autofill... to make filling the form a bit easier.
[bookmark: packaging-layers-in-a-single-geopackage][bookmark: _Toc165644538]Packaging layers in a single geopackage
At the moment all your output layers are in individual geopackages. This is messy and would make it harder to share your data with colleagues.
Luckily QGIS includes a tool which will package layers in a single geopackage.
[image: images/svg/videocam-black-24dp.png] Packing layers in a single geopackage in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the processing toolbox and search for Package layers. You should find the tool under the Database heading.
· Open the Package layers tool
· Click on the three dots button next to Input layers. Select your twenty visibility layers as shown below and click OK
[image: images/repetition/PackageLayers01_small.png]
Selecting the twenty visibility layers for packaging.
· Untick Save layer styles into GeoPackage - the styles are random anyway, so there isn’t a lot of point in keeping them.
· Click on the three dots button next to Destination GeoPackage and Save to File...
· Browse to the folder where you want to save the output and give your new geopackage a name such as Visibility.
· Click on Save then Run the tool.
[image: images/repetition/PackageLayers02_small.png]
Filling in the form to package layers in a single geopackage.
Now you should be able to remove the twenty visibility layers from your map and add them in again from the single geopackage. Feel free to delete all the individual geopackages from your computer.
[bookmark: documenting-your-graphical-model][bookmark: _Toc165644539]Documenting your graphical model
When creating models, as with scripting, it is a very good idea to document them. This involves adding comments which don’t make a difference to how the model runs, but do give information that is useful if you, or someone else, needs to make changes to the model in the future. While you’re writing the model it’s easy to think that you will remember why you have done certain things, but if you come back to it in a year’s time you’ll be thinking “why did I do it that way?” Comments can help you to remember that without wasting time.
You can also add help which appears in the tool when it is being run. Remember the panel to the right in the processing tools? The helpfulness of the information in those varies greatly and this is your chance to provide really useful help to anyone who may run your model.
[bookmark: adding-comments]Adding comments
Comments appear in the Model Designer and are useful to remind yourself, or any other developer, of what things do and why you did things that way.
Comments are attached to individual elements of your model.
[image: images/svg/videocam-black-24dp.png] Documenting graphical models with comments in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To add comments:
· Open your model for editing.
· When adding an element (input or algorithms) to the canvas you’ll see that there is a second tab called Comments. Type information into the box on this tab and click OK.
· To add a comment to an element which is already on your canvas either right-click and Edit Comment or click on the three dots on the element and then go to the Comments tab. Type information into the box on the comments tab and click OK
· You can also change the colour of the background of the comment while you are on the Comment tab.
[image: images/repetition/CommentAdding_small.png]
Adding a comment to the input Elevation data parameter.
· The comment will be added to the canvas with a link to the element.
[image: images/svg/create-black-24dp.png] Adding a comment to input
Follow the instructions above to add a comment to the input Elevation data
Type the following into the box:
This is a merged raster DTM or DSM.
Then click OK to save it.
[image: images/repetition/CommentOnCanvas_small.png]
The comment linked to the Elevation data element on the canvas.
[image: images/svg/create-black-24dp.png] Add comments to your model.
Have a look at the other elements on your model. Add any further comments that you think would be useful to you if you came back to work on this model again in 12 months time. Remember that you can add comments to algorithms as well as input.
[bookmark: adding-help-for-users]Adding Help for users
The Comments are aimed at a developer, but you may also want to add Help for people who actually use your model, for example if you are producing a model tool to automate a workflow for a team you are working with.
The Help will appear in the help panel when the tool is being run.
[image: images/svg/videocam-black-24dp.png] Adding help for users to a graphical model in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To add help:
· Within the model designer go to Model > Edit Model Help...
The Help Editor should open. You may need to enlarge the window a bit to see all the areas.
· The area at the top shows how your help will appear to users
· Select the element you want to add help to in the list at lower left
· Type your help information in the box at lower right
[image: images/repetition/HelpEditor_small.png]
The Help Editor. Select an element and type in the help that you wish your users to be able to see.
· When you’ve typed in help click OK to save it.
[image: images/svg/create-black-24dp.png] Run your model and look at the help.
Now open your model as if you are going to run it (you can do this from within the Model Designer) and have a look at how your help appears.
If you can’t see it you may need to click on a small black arrow at the top right of the window.
Note that your comments don’t appear in this view, just the help that you’ve created.
You don’t need to actually run your model now, unless you want to!
[image: images/repetition/HelpRun_small.png]
The model dialog showing the help that your users will see.
· You can close the run dialog now.
[image: images/svg/create-black-24dp.png] Add help to your model
Add any further help to your model that you think will be useful.
[bookmark: exporting-your-graphical-model][bookmark: _Toc165644540]Exporting your graphical model
Sometimes it is useful to have a copy of your model as an image file. It shows the process that you’ve used and also serves as a reminder to you of the tools and data that you used.
[image: images/svg/videocam-black-24dp.png] Exporting a graphical model in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: exporting-as-an-image-or-pdf]Exporting as an image or pdf
QGIS gives you the choice of three formats for exporting your model, Image, PDF or SVG.
· If you export as Image you’ll be able to include it in a Word or PowerPoint document, or open it in an image editor on your computer.
· PDF is better if you just want to be able to open it on your computer.
· SVG is a vector format which will open in the Inkscape vector editing program and can then be edited.
To export your graphical model:
· Either use the menu at Model > Export and choose the option you want to use.
· Or use the buttons on the toolbar, and again choose the option you want to use. (Remember you will get tooltips when you hover over buttons in QGIS.)
[image: images/repetition/ModelFinal_small.png]
The model exported as an image file.
[bookmark: exporting-your-model-as-a-python-script]Exporting your model as a python script
You’ll notice that there is a fourth export option - Export as Script Algorithm... or Export as Python Script... depending on whether you use the menu or the buttons.
· Click on the Export as Script Algorithm... button on the toolbar
A window should open which contains the python code for your model.
[image: images/repetition/ProcessingScriptEditor_small.png]
The python code behind your graphical model. This was opened using the button on the toolbar.
You can now use the Save button at the top of the window to save your code to a Python file which can then be opened in a text editor such as TextEdit on Mac or Notepad++ on Windows.
Alternatively use the menu to Model > Export > Export as Python Script... and save the file straightaway.
[image: images/svg/create-black-24dp.png] Have a look at the Python Script.
Have a look at the Python script you have exported, either in the Processing Script Editor or in a text editor. Can you pick out the input and the algorithms that you added? How are the outputs passed from one algorithm to the next?
Note also that any comments that you added to your model are added as comments to the python script.
[bookmark: python-in-qgis][bookmark: _Toc165644541]Python in QGIS
I’m not going to cover Python here, but there is a very good introduction available online called PyQGIS 101: Introduction to Python programming for non-programmers.
[bookmark: final-output-for-this-chapter][bookmark: _Toc165644542]Final output for this chapter
The output for this chapter is a model rather than a map. The data that you have produced would create a map very similar to the one at the end of the Elevation models 2 chapter.
Instead, if you wish to keep a record of what you’ve done, export your final model as an image file using the instructions above.
[image: images/repetition/ModelFinal2_small.png]
Possible final model from this chapter. You can move the elements around on the canvas to neaten up the presentation.
[bookmark: Xd5ed7a75c12f05b9ed37118194e4a3997db4436][bookmark: _Toc165644543]Recommended reading for graphical models and batch processing
[bookmark: graphical-models]Graphical models
· QGIS User Guide information on graphical modeler.
· Automating GIS workflows with QGIS - full course from Spatial Thoughts, includes graphical models.
· Advanced QGIS expressions and modelling - also Spatial Thoughts.
· QGIS Open Courseware tutorial on using the graphical modeler. Video tutorial to go with written course.
[bookmark: batch-processing]Batch processing
· Batch processing using Processing framework - QGIS Tutorials
[bookmark: python]Python
· PyQGIS 101 - a basic introduction to using python in QGIS from Anita Graser (Underdark). 
[bookmark: dynamic-or-time-data-in-gis][bookmark: _Toc165644544]Dynamic or time data in GIS
Last Modified: 03 May 24, 15:58:53
Checked in QGIS version 3.30.
The background to using dynamic or time data in GIS to create an animation will be covered in the lecture, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[image: images/svg/info-black-24dp.png] Optional chapter
Note that this chapter is optional. It adds to your knowledge and experience of GIS and is an engaging way to display and analyse data, but it is not essential.
If you are enjoying the GIS and have time in the final practical, then try working through this or the chapter on viewing 3D data to explore some fun techniques and different data.
If you don’t have the time, then don’t feel you have to do this chapter now. If you’re aware these techniques are possible, you can come back to this chapter in the future.
[bookmark: learning-outcomes-1][bookmark: _Toc165644545]Learning outcomes
When you have completed this section of the workbook you will be able to
· Explore data which includes a dynamic, time component as well as a spatial component.
· Display dynamic data with GIS and graphics tools to demonstrate patterns in time in an engaging fashion.
[bookmark: X67c1e2650755cee4f06b64e9287266ede93c431][bookmark: _Toc165644546]Introduction to dynamic or time data in QGIS
For most of this course we have been looking at data which displays what is happening at a single moment in time. Many datasets have an additional component - time. If we can display time in GIS it becomes possible to analyse changing patterns. This can be done with a series of static maps, or it is possible to link time series together into an animation. This chapter covers a simple example, but does demonstrate how to generate an animated gif that can be shared with your audience and which can engage them effectively with your data.
Red Kites (Milvus milvus) were very common in Britain, but persecution led to there being only a small population left in Mid-Wales until a successful reintroduction programme which began in the 1990s. Now you can see Red Kites over most parts of Leeds. Find out more about Red Kites on the British Trust for Ornithology pages.
For these exercises, we’ll look at occurrence data for the Red Kite and animate a map of observations from 1990 to the present day to see how they have spread.
[bookmark: data][bookmark: _Toc165644547]Data
I have downloaded occurrence data for the Red Kite from the Global Biodiversity Information Facility (GBIF). This is an enormous resource of world-wide species data. If you want to download your own data, you will need to register for free. Once you’ve registered, obtaining data isn’t entirely straightforward, which is why I am providing the data for you.
[bookmark: occurrence-data-from-gbif]Occurrence data from GBIF
You can see more information about how I filtered the data at the link in the citation below. Note that this is also the citation you should add to any maps you create with this data.
GBIF.org (9 April 2024) GBIF Occurrence Download https://doi.org/10.15468/dl.n7e6w9
The data is downloaded as a tab-separated values file. I needed to clean it up a bit and check the dates were all in the same format, then export it to comma-separated value (.csv) format. This cleaned up version is the one I am providing for you.
· Download RedKite_ed.xlsx from Minerva and save it to your project folder.
· Open the spreadsheet and have a look at the data.
· The important fields for this exercise are the decimalLatitude, decimalLongitude and eventDate fields.
[bookmark: background-map-2]Background map
We’ll start with a simple background map for these exercises.
· Open a new blank map in QGIS.
Either:
· Type world into the coordinates box in QGIS to generate map of the countries of the world.
· Or go to naturalearthdata and download a Large scale data, 1:10m > Cultural > Admin 0 - Countries layer, unzip the download and add the layer to a map in QGIS. Style it as a single, neutral colour such as grey.
[bookmark: Xba601c9d7a7047b94e521ccf960fcb61775bdae][bookmark: _Toc165644548]Adding the species occurrence data to your map
The species data is in a spreadsheet file (xlsx), so we can use the Spreadsheet plugin to add it to QGIS. See the instructions in section 8.8 of the main workbook if you need a reminder of this.
To add the data:
· The input filename is the Excel file you’ve downloaded.
· Check that Header at first line is ticked if you don’t have any column headings except field 1, field 2 etc.
· The Geometry is important:
· Set X field to decimalLongitude.
· Set Y field to decimalLatitude.
· Set Reference system to EPSG:4326 - WGS84.
· When you’ve filled in the form, click OK.
[image: images/dynamic/SpreadsheetImport_small.png]
Importing the species occurrence data with the Spreadsheet plugin. Remember to set the Geometry.
· Zoom to the new layer. You should be able to see a map of Great Britain and Northern Ireland with lots of points.
[image: images/dynamic/ImportedData_small.png]
The imported species occurrence data for Red Kites.
· Save your map project.
[bookmark: reprojecting-the-data-and-project][bookmark: _Toc165644549]Reprojecting the data and project
The CRS of the map and data is set to EPSG:4326 - WGS84. As we are working with data for Great Britain, it would be good to set the CRS to British National Grid (EPSG:27700).
If you’ve downloaded data for the whole world, or for another country, you can decide on a relevant CRS. Use the epsg.io web page if you need help in deciding which CRS is best for your area.
· Right-click on the species occurrence data and Export > Save features as....
· Save as GeoPackage format and click the three dots button to decide where to save the data.
· Change the CRS to EPSG:27700 - OSGB36 / British National Grid.
· Then click OK.
The new layer should be added to your map. Remove the original layer so it doesn’t confuse you later.
We can also save a small part of the world map to our project folder and reproject that.
· Right-click on the world map layer and Export > Save features as...
· Save the data as a new layer in the same GeoPackage.
· Set the CRS to British National Grid.
· Tick the box next to Extent and set to Map Canvas Extent (assuming you’ve zoomed to layer on the species occurrence data).
· Click OK.
Again, check the layer has been added to your map, then remove the original layer.
[bookmark: reprojecting-the-project]Reprojecting the project
So far the map hasn’t been changed to British National Grid.
If you’re sure your layers are the correct CRS:
· Right-click on one of the layers.
· Select Layer CRS > Set Project CRS from Layer.
This is a relatively simple way of setting the project CRS.
[bookmark: preparing-the-datetime-data-for-display][bookmark: _Toc165644550]Preparing the date/time data for display
We have the species occurrence data displayed on our map. With all the points visible at once it is very crowded and doesn’t show how the Red Kite has expanded its range since 1990.
To be able to view the data through time we need to pull out the time information from our attribute table.
[image: images/svg/create-black-24dp.png] Explore your data and look for a date or time field
Explore your data by looking at the map and the attribute table.
• Is there a column that gives you date and/or time, i.e. temporal, information?
• Check the Fields tab in the layer properties. Does the date/time field you’ve picked out have a data type of Date & Time? If so, you can use that field to animate your data just as it is. If it doesn’t, then we need to do a bit more work.
In the case of this species occurrence data, there is a field called eventDate which holds a date (such as 2024-04-08), but the field type is Text (string).
[image: images/svg/warning-black-24dp.png] Warning
Note that you may check the dateTime field and discover it is set to the Date type. If you do, this is fine and you can work with that rather than having to do the conversion below. Do check that the format of the dates is yyyy-MM-dd or yyyy/MM/dd, though. You can do this by opening the attribute table and looking at the data in that column.
[image: images/dynamic/LayerPropertiesFields_small.png]
Checking the data type of the eventDate field - showing it is a text type.
Changing a text field to a date field isn’t as simple as just using the Refactor fields tool. QGIS expects a particular date/time format and our data isn’t the correct format so we need to convert it and create a new field.
[bookmark: converting-the-datetime-format-in-qgis]Converting the date/time format in QGIS
[image: images/svg/videocam-black-24dp.png] Converting the date/time format in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To convert the eventDate field to a date/time type:
· Open the attribute table of the species occurrence data.
· Open the Field calculator by clicking on the abacus button at the top of the attribute table.
· Enter an Output field name which will remind you what that field contains, e.g. DateTime.
· Set the Output field type to Date & Time.
· In the search box above the centre box type date.
You should be presented with some options which include to_datetime. Click on that to look at the information in the right-hand box. This looks like what we need and there are some examples given.
· Set up an expression similar to the following. Using your own field names where necessary.
to_datetime("eventDate" , 'yyyy-MM-dd')
Where 'yyyy-MM-dd' is the current date format.
· yyyy = year, e.g. 2024
· MM = month, e.g. 04
· dd = day, e.g. 08
Check the dates in your attribute table to check this matches them. Other alternatives include:
· 08/04/2024 = dd/MM/yyyy, for example.
Once you have it correct, the Preview below the expression box should look something like:
<datetime: 2024-04-08 00:00:00 (GMT Standard Time)>
· Click OK to add the new column to your attribute table.
· Check the column has been added correctly, then save the edits and stop editing.
[image: images/dynamic/FieldCalculatorDateTime_small.png]
Creating a new Date/Time field from the existing field.
· Open the attribute table again, sort the new date/time column by clicking on the column heading and make a note of the earliest and latest dates in your data.
Mine runs from 01/01/1990 to 31/12/2022, but yours will be different to that as it depends on the date you’ve downloaded it.
[image: images/svg/help_outline-black-24dp.png] What are the earliest and latest dates of your data?
Make a note here:
[bookmark: setting-up-temporal-control][bookmark: _Toc165644551]Setting up Temporal Control
Once you have the data in your map project you can start setting it up to appear dynamically by using the Temporal Controller.
[image: images/svg/videocam-black-24dp.png] Setting up Temporal Control in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To set up temporal control:
· Open the Layer properties for the species occurrence layer.
· Go to the Temporal tab from the list on the left.
· Click next to Dynamic Temporal Control to activate for this layer.
· If you click Apply now, the little clock icon should appear next to the layer in the Layers panel.
[image: images/dynamic/ClockIconAnno.png]
The Clock icon next to the species layer in the Layers Panel.
This dialog controls many of the temporal settings for this layer.
· Set Configuration to Single Field with Date/Time - as this matches the field in our layer.
· Set Limits to Include Start, Exclude End (default) - this makes sense for the species distribution data which only has a single date/time.
· Check that Field is set to the field you set up above - in this case DateTime.
· You can choose Event duration depending on how long you think each feature should stay on your map. I’m going to set it to 1 months in the first place so features don’t stay on the map for too long. You can easily change this later.
· Accumulate features over time means that once a feature has appeared, it stays on your map. I’m going to leave that unticked for now, but again you can change this later.
· Click OK to apply the settings and close the properties window.
[image: images/dynamic/TemporalProperties_small.png]
Setting the temporal properties to the correct Date/Time field.
Next we need to set up the Temporal Controller panel.
· Either click the Temporal Controller button on the toolbar or go to View > Panels and tick Temporal Controller. The panel should open across the top of your map.
[image: images/dynamic/TemporalController01_small.png]
The Temporal Controller panel when it first opens.
Initially the Temporal Controller will be disabled.
· To enable the Temporal Controller, click on the right-hand button - the one with the small green arrow.
The full range of settings should appear and you should notice fewer symbols on your map, or even none!
· Start by setting the Animation range dates to the earliest and latest dates in your dataset (you should have made a note of these above). You can click on the refresh button at the end of hte Animation Range boxes to Set to full range.
[image: images/dynamic/TemporalController02_small.png]
The activated Temporal Controller panel with controls to play the dynamic visualisation.
Try out some of the controls:
· You can move the slider manually to see distributions at different times.
· Press the Play button to play the animation at the rate controlled by the Step controller.
· Try changing the Step control from the initial value of 1 hours to 1 years.
As this is a fairly long animation range, you may want to set the step controller to a longer time period. Try out different intervals to see what suits your data best without taking too long.
Changing the rate should shorten the total time of the animation as each step (or “frame”) covers a longer period.
[bookmark: X50cad5630e15acf47c2ab7a415def5e6916ca11][bookmark: _Toc165644552]Displaying dynamic data as a series of maps
If you want to include a series of maps showing data through time in a report or publication, it is possible to use temporal range in a QGIS layout to set that up if you’ve already set the Dynamic Temporal Control in the layer properties. You don’t need to have created an animation with the Temporal Controller to do this.
[image: images/svg/videocam-black-24dp.png] Using Temporal Range in QGIS Layout to display a series of maps
This video clip can be found in the module area of Minerva or in the full list of video clips.
Start by creating a layout in the usual way.
· Add a map to the layout and set the size of the map, the scale and the extent how you want it to be.
· With the map selected, go to the item properties. Scroll down to find the Temporal Range sub-heading and tick in the box next to it.
This should give you boxes for the start and end dates.
· Set the Start and End dates as you wish. For example, I’m going to set them to 2000-01-01 00:00:00 and 2005-01-01 00:00:00 (the end date is exclusive), but what you put in will depend on your data.
[image: images/dynamic/LayoutTemporalRange_small.png]
Setting the start and end dates for Temporal Range in the item properties of the map layout.
You should see the data on the map change as you enter the dates.
· With the map still selected, copy it with the <Ctrl>-C keyboard shortcut and paste a new copy, using <Ctrl>-V.
· Move the new copy to where you want it, then go to the item properties for that map and change the start and end date. This time I’m going to enter 2005-01-01 00:00:00 to 2010-01-01 00:00:00.
Again, you should see the data on the new map change to the new dates.
· Repeat this as many times as you need to.
You can, of course, add relevant titles, keys etc to your layout before you export it as an image or pdf document, but the basic idea should be similar to the following example.
[image: images/dynamic/OspreyLayout_small.png]
Example of a series of maps showing change with time using the Temporal Range in Layout view.
[bookmark: X65c54154888961089ba0e65edea41b67de266dc][bookmark: _Toc165644553]Adding information to the map with Decorations
To export this data as frames to create an animation, you won’t be able to set up a layout. You’ll be exporting images directly from the map canvas. This means you won’t be able to use the usual layout tools to add extra elements, such as a title.
Instead you can use “Decorations”.
[image: images/svg/videocam-black-24dp.png] Adding Decorations to the map view in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: adding-a-dynamic-title]Adding a dynamic title
Let’s start by adding a title which includes the current date of your data:
· Go to View > Decorations > Title Label.
· When the Title Label Decoration window opens, click next to Enable Title Label.
· Type the title you want in the text box, e.g. “Distribution of Red Kite sightings”. Don’t put a date in yet.
As this view is dynamic, it makes sense to get the dates dynamically from the animation.
· Click on Insert or Edit an Expression.
· At the top of the central box type “time” to seach for time-related expressions. Use the results to compile the following expression in the left-hand box:
format_date( @map_start_time, 'd MMMM yyyy' )
[image: images/dynamic/TitleDateExpression_small.png]
Compiling the expression to display the current date on your animation.
Check below that the Preview is a correctly formatted date, then click on OK to apply it.
· In the Title Label Decoration panel, choose a font, background colour etc for your title.
· Apply allows you to try out what your are setting.
· Select OK once you are happy with it.
[image: images/dynamic/TitleLabelDecorationSettings_small.png]
The Title Label Decoration Settings.
Your title should appear in the location that you’ve chosen on your map window.
Try changing the map with the time slider again. The date should update to show the current date of the data for each frame.
[bookmark: adding-copyright-information]Adding copyright information
To add copyright information:
· View > Decorations > Copyright label.
This works in a very similar way to the title, but this time you won’t need to add any dynamic text, so just have a go.
The citation for the GBIF data is:
GBIF.org (9 April 2024) GBIF Occurrence Download https://doi.org/10.15468/dl.n7e6w9
You can add other decorations in this way, but for this map you shouldn’t need to.
Don’t forget to save your map!
[image: images/svg/create-black-24dp.png] Check your animation
Try pressing the Play button on the Temporal Controller and check that everything is working as it should be and you are happy with the speed of animation.
[image: images/dynamic/MapInQGIS_small.png]
The final layout in QGIS with a title and copyright information.
[bookmark: creating-an-animated-gif-to-share][bookmark: _Toc165644554]Creating an animated gif to share
Being able to play a dynamic map in QGIS will enable you to spot patterns in time and place, but this will be even more usful if you can export the animation in some way to share with people who don’t have QGIS. Luckily you can.
There are various ways to do this. I’m going to show you how to use entirely open-source software (QGIS and GIMP), to create an animated gif.
Other tutorials on the web will show you how to create a video instead.
The steps we will follow are:
1. Export the dynamic view from QGIS as frames to create a series of images.
1. Opening the images in GIMP image editing software.
1. Setting animation options.
1. Exporting the series of files as an animated gif.
[bookmark: exporting-the-dynamic-view-as-frames]Exporting the dynamic view as frames
The Temporal Controller allows you to save your map as an image for each time step.
[image: images/svg/videocam-black-24dp.png] Exporting frames with the Temporal Controller in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Check that your map is set up as you want it to be in QGIS, with the time step set to something that allows changes in your data to be seen relatively quickly. You don’t want this to take too long to run! I’ve set the steps to 1 years.
To export the images:
· Create a new folder in your map project folder to hold the resulting images.
· In the Temporal Controller Panel, click on the disk icon next to the time period to Export Animation.
· Check the Template, which is the name your output files will have. The #### indicates that the files will be numbered in the order they are generated.
· Select the Output directory as the folder you’ve just created.
· Extent can be a layer, but in this case Map Canvas Extent may work better. Resize the map view if you need to keep the size down a little (your extent and output size may vary from the example below because your data may be different).
· You don’t want the output images to be too large, as you need to keep down the size of the final animated file. If your Output width and Output height are both below 1500 px, don’t worry about changing them. Otherwise:
· Click the padlock symbol to the right of Output width and Output height.
· Set the higher of the two numbers to something like 1500 px. The other number should reset automatically in proportion.
· You can experiment with this when you see the final output and make changes if you need to.
· Make a note of the Output width and Output height - you’ll need these later.
· Tick to Draw active decorations: title label, copyright label (and any others you chose to add).
· Check the Range and the Step.
· Then click Save to export the multiple files.
[image: images/dynamic/ExportMapAnimation_small.png]
The settings to export individual frames for your map animation.
· Wait for the export to complete, then check the images that have been generated. For example, are you happy with the extent?
If necessary, you can delete these, change the settings and generated another batch.
· Save your map and close QGIS.
You’ll need to know the pixel size of your images. If you didn’t make a note of it when exporting the images in QGIS:
· In My Computer, right-click on one of the images and go to Properties.
· Click on the Details tab and look for Dimensions.
[image: images/svg/help_outline-black-24dp.png] What is the pixel size of your images?
Make a note of the Width and Height here:
[bookmark: obtaining-gimp]Obtaining GIMP
· Within the University, or on Windows computers, GIMP 2.10.32.1 is available via AppsAnywhere. Go to AppsAnywhere, search for GIMP, and load in the usual way. These instructions assume version 2.10.32.1 but should work in any higher version.
· GIMP is open-source software and can be installed on Windows, Mac and Linux. GIMP web page.
[bookmark: creating-the-animation-in-gimp]Creating the animation in GIMP
The instructions below are based on a tutorial on how to create an animated GIF.
[image: images/svg/videocam-black-24dp.png] Creating an animated gif in GIMP
This video clip can be found in the module area of Minerva or in the full list of video clips.
To create an animated gif in GIMP:
· Open GIMP.
· Create a new image - File > New then enter correct size (refer to pixel size of images). Set X resolution and Y resolution under Advanced Options (you’ll probably need to click on it to get the options) - don’t make it too high or your final file will be too large! 95 dpi should be fine, and keep both the same.
· Click OK to create the new image.
[image: images/dynamic/GimpCreateNewImage_small.png]
Creating a new blank image in GIMP. Your Width and Height will be different - use the sizes you made a note of above.
Now you can add your images to the blank GIMP canvas.
· Add images as “frames” starting with the first image at the “bottom” of the layers.
· You should be able to just drag and drop images from My Computer onto the canvas (not the layer panel!) and each one is added as the next layer up. Select all images in your Explorer by using the short cut Ctrl-A.
· The Layer panel should be visible on the right of the window. If it isn’t, open it with Windows > Dockable Dialogs > Layers.
· Check that all your images are in numerical order with the lowest at the bottom and the highest at the top.
· In the layer panel, right-click on the background layer, which should be at the bottom of the list, and Delete layer.
[image: images/dynamic/GimpLayerPanel_small.png]
The order of your images as layers in the layer panel in GIMP. You may not have the same number of images, that doesn’t matter.
· Save the image in the same folder as your map. This will save as an .xcf document.
· To keep size down you can use an indexed colour mode instead of RGB. Image > Mode > Indexed. Stick to defaults for now! For some images this won’t make much difference.
To export the animation
· File > Export As - give the output a name and append .gif as the extension, e.g. RedKitesAnimation.gif. Just type to replace whatever is there when you open the dialog and make sure the final part of the name is .gif.
· Then click Export.
· In the dialog that opens choose options as follows:
· Select As animation by ticking in the box next to it.
· Untick GIF comment:, unless you want to add a comment of your own…
· Frame disposal where unspecified should be set to One frame per layer (replace)
· Tick both Use delay entered above for all frames and Use disposal entered above for all frames.
· Change Delay as required to change speed of animation - try starting with something like 300 milliseconds. You don’t want the animation to be too quick!
· Click Export to export the animated gif.
[image: images/dynamic/GimpExportImage_small.png]
The dialog to export an animated gif from GIMP.
Wait while GIMP exports the file - it may take a bit of time so be patient!
You should be able to open the resulting .gif file in a graphics program to check it. It should automatically run when you open it.
[image: images/svg/info-black-24dp.png] Opening an animated gif on Windows
If you don’t have a graphics app that will open the gif and show the animation, try dragging and dropping the .gif file from My Computer into the address bar of your web browser. Depending on security settings this should work in Edge, Firefox or Chrome.
· Are you happy with the speed?
· To change the speed, Export from GIMP again, changing the Delay as required. I found I needed to change it to 600 milliseconds to slow down the speed.
· What is the file size of your final file?
· If it’s too large, and takes too long to export or crashes GIMP when you do, you may need to export the images from QGIS again, but reducing the height and width as you do so.
[image: images/dynamic/RedKitesAnimation.gif]
My final animated map of changes in distribution of Red Kites.
[bookmark: viewing-your-data-in-3d][bookmark: _Toc165644555]Viewing your data in 3D
Last Modified: 18 Apr 24, 11:25:33
The background to viewing your data in 3D will be covered in the lecture, and the presentation and any other supporting materials will be available in Minerva. The lecture should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[image: images/svg/info-black-24dp.png] Optional chapter
Note that this chapter is optional. It adds to your knowledge and experience of GIS and is an engaging way to display and analyse data, but it is not essential.
If you are enjoying the GIS and have time in the final practical, then try working through this or the chapter on dynamic data to explore some fun techniques and different data.
If you don’t have the time, then don’t feel you have to do this chapter now. If you’re aware these techniques are possible, you can come back to this chapter in the future.
[bookmark: learning-outcomes-2][bookmark: _Toc165644556]Learning outcomes
When you have completed this section of the workbook you should be able to
· demonstrate how to import height data in to GIS
· display a map in 3D to aid the interpretation of your data
· extrude vector data for 3D display based on a value from the attribute table
[bookmark: introduction-3][bookmark: _Toc165644557]Introduction
Once you have created features and data in GIS you can view the map in 3D and see how your data relates to other features. Being able to view landscapes or data in 3D can sometimes make relationships more obvious.
You’ll be able to export 3D views and profiles from QGIS to include in other reports and layouts.
[bookmark: data-to-download-1][bookmark: _Toc165644558]Data to download
For this chapter I have created a project which contains all the data that you will need to complete the exercises.
· Download ThreeD_Q.zip from Minerva.
· Unzip the folder to your GIS folder. You should have a folder called ThreeD_Q which contains a qgz file and multiple folders of data.
· Open ThreeD.qgz in QGIS. It should look something like the image below. Most of the layers in the layers panel are not visible.
[image: images/three_d/InitialProject_small.png]
The initial project when you first open it.
You’ve used most of these data layers before in previous chapters but to save time I’ve set the project up this time.
[bookmark: creating-a-profile-graph][bookmark: _Toc165644559]Creating a profile graph
QGIS enables you to draw a profile graph across your map using z values in your raster surface files or heights above sea-level. You have both an elevation layer and a rainfall surface on your map so you can try both of types of surface.
There is a plugin called the Profile Tool which is very simple to use, but which has limitations. If you would like to try that then you’ll probably find it pretty easy to use. Instead, for these exercises, I’ll take you through how to use a plugin called qProf. This allows us to have control over the x and y axes, and to export the graph in such a way that it is possible to display it properly on a layout.
· You’ll need to install the qProf tool plugin by going to Plugins > Plugin Manager in the same way as you installed the Spreadsheet Layers plugin.
Don’t worry that the description of this tool talks about plotting geological data, you’ll be using it without doing that.
· To open qProf go to Plugins > qProf > qProf.
The qProf tool window should open to the right of your map area.
[image: images/three_d/OpenProfileTool_small.png]
The qProf window.
[image: images/svg/videocam-black-24dp.png] Creating a profile graph in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
The first thing you need to do is select the layer that contains your z or height data.
· Check that the Topography tab is selected at the top.
· Click on the button to Define source DEMs
· From the list select T5merged, or your height layer, and click OK.
Next you need to define the input line, i.e. the line of your profile. We’ll start by using a temporary, or Digitized line.
· Check that the T5hsh layer is visible on your map - this shows the extent of the height layer.
· Make sure that Digitized line is checked on the qProf dialog, then click on the Digitize line button.
· You are given brief instructions. Click OK when you’ve read them, then on your map:
· left-click on the top left of the visible hillshade layer
· left-click on the bottom right of the visible hillshade layer
· right-click somewhere on the map to stop drawing the line
You should end up with a red line across your map.
Now you can generate the profile.
· First make sure that DEM input is checked, then click on the Read source data button. Hopefully you’ll get a message saying Data profile read.
· Next click on Calculate profile statistics. You should get a small window full of numbers. Close this, it shows that qProf has successfully created points at regular intervals along the line and assigned a height to them from the DEM.
· Then click the Create topographic profile button. You’ll get a Topographic plot parameters window at this stage.
· Set vertical exaggeration to 3 for now so that you can see what is going on - you can set it higher if you particularly want to show the shape of the land, but for scientific purposes you will usually need to set it to the real-world exaggeration, which is 1.
· Leave the Plot z max value as whatever qPlot has calculated.
· As this is an inland area in West Yorkshire it is very unlikely that the minimum height will be less than sea-level, so set Plot z min value to 0.
· If you want to change the colour of your line you can click on Elevation line visibility and colours, then on the colour patch. Change the colour if required then click on OK.
[image: images/three_d/TopographicPlotParameters_small.png]
Filling in the Topographic Plot Parameters. Particularly note the vertical exaggeration.
· Now click on OK to generate the profile. A simple profile window should open.
[image: images/three_d/qProfProfile_small.png]
The generated profile. You can enlarge the window to make the profile larger.
[image: images/svg/create-black-24dp.png] Experiment by drawing different lines
Click on Digitize line again and try drawing a few different lines across your map in any direction you fancy and see what the terrain is like. You’ll need to click on all three buttons in the lower part of the tool again.
· The x axis shows the distance in map units, which in this case will be metres. You can check this in the project properties if you need to.
· The y axis shows the values of your chosen “surface”. In this case the DTM. Again, this is map units so for this map is in metres.
· Note that if you have set the vertical exaggeration to anything except 1 the x and the y axes will not be in proportion to each other. Also note that if you follow the instructions further on for adding a profile to a layout, this won’t make any difference as it will end up to scale anyway.
[bookmark: Xa01eedb46f3b35116790e7c8810171d736d8481]Adding a second profile to the same graph
It is possible to add multiple layers to provide z values for the same profile graph.
· You also have a rainfall layer on your map. This shows the total rainfall for the area in 2016.
· Click on the rainfall layer in the Layers panel, then click on Define source DEMs on the qProf tool panel.
· Tick next to both T5merged and Rainfall2016 then OK
· Digitize a line from top left to bottom right of the hillshade.
· Click on the Read source data, Calculate profile statistics and Create topographic profile buttons again, this time setting the rainfall as a blue line.
The output should look something like the image below. Changing the colour of one of the lines makes it simpler to remember which is which.
[image: images/three_d/qProfProfileRainfall_small.png]
The Profile tool panel with two elevation layers set - terrain in brown and rainfall in blue.
Unfortunately it isn’t possible to edit the y axes independently so that you have the two profiles on different scales. If you want to do this you would probably need to export the profile graph as svg format, open it in Inkscape or another graphics editor, and make the changes there.
· When you’ve finished experimenting just close the qProf tool panel - this will clear the settings that you’ve been using.
[bookmark: Xda7a5faec14b3075b8a17da2adf06d205895dfb]Using a feature class for the line on the map
So far you’ve only used a temporary line on the map for the line of the profile. When you close your map this line will disappear. If you are going to include the profile on the map layout you also need to show the line of the profile on the map. To do this you can create a feature class and digitise a line across the map. It is also possible to use an existing line feature, such as a river or a road, to create the profile and we’ll do that now.
· Reopen the qProf Tool again in the same way as before.
· Add the T5merged layer as the Input DEM
· Make sure you have a feature class containing a line feature in the Layers panel - on this map you have a layer called Washburn which includes a single line feature showing the course of the River Washburn. Turn this on now and have a look for it on the map. Remember that you can Zoom to layer to pinpoint where it is on the map.
· Under Input line click to check next to Line layer
· Click on the Choose layer button.
· The Input line layer: will be Washburn.
As there is only one line in this feature class you don’t need to worry about the other settings.
· Click OK
· Click on the Read source data, Calculate profile statistics and Create topographic profile buttons again to generate the profile. Set vertical exaggeration to 5 and Plot z min value to 0.
[image: images/three_d/WashburnProfile_small.png]
The topographic profile of the River Washburn.
[image: images/svg/create-black-24dp.png] Checking the data
Have a look at the profile graph. Does this look as you think it should do for a river? If not, why do you think this might be?
[bookmark: saving-the-profile-graph]Saving the profile graph
You can save your profile graph as an image to add to other work, e.g. in Word or PowerPoint.
· Click on the Export tab at the top of the qProf panel
· Click on the Figure button.
· You can change the size of the image and various other parameters here
· Click on Choose to navigate to where you want to save the graph and give it a name. For now give the file name an extension of .tif to save the output as an image.
· Click on Save then OK to actually save it.
· For now keep the qProf dialog open - you’ll use the same profile for the next section.
The resulting tif file can be added to reports or map layouts, but see below.
[image: images/svg/create-black-24dp.png] Have a look at the output
Find your saved profile png file in your file explorer and open it to have a look at it. It should open in your computers default graphics editing or viewing program.
Check that it looks as you would expect from what you could see in the qProf tool.
This output is fairly basic. It simply gives you the profile without any labels, titles etc.. If you are going to include a profile graph on a map layout or in a report you will need to annotate it with titles, labels etc.
One way to add annotations is to export the figure as .svg format, open the file in an editor, such as Inkscape [footnoteRef:5] and add the annotations there. [5:  Inkscape is open source and freely available to download and install on Windows, Mac and Linux. If you want to learn how to use it I have created Interactive Inkscape Worksheets which can be downloaded from my website.] 

If you are going to include your profile on a QGIS layout then there is an alternative which I’ll show you below.
[bookmark: adding-annotation-to-a-profile-graph]Adding annotation to a profile graph
Sometimes producing certain output in GIS can involve looking for alternative ways to do something or use particular techniques. This is a prime example. Using the qProf tool it is possible to export the data in a way that allows you to plot the profile as a line on a map. This then opens out the possibility of including it on a layout and using grids to add the axes, labels to add the title, and a key.
[image: images/svg/info-black-24dp.png] Do you need to do this section now?
If you don’t need to do this right now I’d suggest missing out this section as it is quite long. Go straight on to the section on viewing 3D topography in QGIS, you can always come back to this section if you need it later.
If you do need to do this now the instructions below cover exporting the data from qprof, then importing it to QGIS so that you can set up the profile. There are some ideas for how to annotate and style your profile graph, but use the layout techniques that you’ve already covered too.
[image: images/svg/videocam-black-24dp.png] Using profile data to display a profile graph on a layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: X09c869ba5c27daec72c249f5e51e8cd5b670fa1]Exporting a csv file with the profile data
· If you don’t already have qProf set up to show a profile for the River Washburn then follow the instructions above again so that you have.
· On the Export tab click on the button to export Topographic profile data.
· Under Profile sources click next to Single DEM and make sure that T5merged is selected [footnoteRef:6] [6:  If you want to show two lines it may be best to export them as separate csv files so it’s more flexible when you set up the layout.] 

· Under Output format select csv
· Click on the three dots button to set the location and name for the Output file
· Click OK
[image: images/three_d/ExportTopographicProfile_small.png]
The settings to export the topographic profile as a csv file.
· You can close the qProf window now.
· Open your new csv file in a spreadsheet program or text editor to see what it contains. You’ll see that it’s an awful lot of numbers!
[image: images/three_d/ProfileCSV_small.png]
The csv file containing the data for your profile graph.
You should recognise the x and y fields as being the grid coordinates. The cds2d column gives the distance along the y axis from 0, or the start of the line. The z column gives the height at that point on the profile taken from the original DEM data.
· Close the spreadsheet or text editor without making any changes.
· Return to your map in QGIS.
[bookmark: adding-the-csv-profile-data-to-a-map]Adding the csv profile data to a map
You need to add the csv file to your map as data, but we don’t actually want it to appear in the same position as the rest of the map so we won’t be using the grid coordinates.
· Remember when you added the Lake District summit points to the Lake District map, you installed the Spreadsheet Layers plugin. You can use that again this time to add the csv profile to your map.
· Add the new csv file as your File name and give your output Layer name a name that will mean something to you.
· Tick the Geometry box and check that the Reference system is set to EPSG:27700
· This is where what we do needs to differ. Instead of setting the X field and Y field as geographic coordinates use:
· cds2d as the X field
· z as the Y field
· Click on OK to add your points as a virtual layer (.vrt).
You won’t be able to see the new layer, but right-click on it in the Layers Panel and Zoom to layer. Now you should be able to see a line of dots across your map. The data has been added at about 0,0 on the British National Grid, which is fine for our purposes. You’ll also notice that any vertical exaggeration is no longer present. This is now at a vertical exaggeration of 1.
[image: images/three_d/ProfilePoints_small.png]
The points making up your profile.
[bookmark: X475c6bcfccc426554e552b972ef9e1ea343d43e]Converting the profile points to a single line
The next stage is to convert that row of points to a single line.
· In the Processing toolbox search for Points to Path
· The Input point layer is the imported csv points, e.g. WashburnQ in my example.
· The Order field is the order the points need to be linked together in. For this it should be prof_id, or something similar which is probably the first field.
· Under Paths give your output line a name - you can save it in the project geopackage.
· Click Run to create the line.
[image: images/three_d/PointsToPath_small.png]
The Points to Path tool to convert the points to a single line.
You can turn off and remove the profile points now, and you should be left with a line across the map window. You can now style this in whatever way you wish to in exactly the same way you would style any other vector layer.
[bookmark: creating-a-profile-on-a-map-layout]Creating a profile on a map layout
Now we come to setting up the profile on a layout in QGIS.
· Make sure that you have done Zoom to layer to the Profile layer in map view
· Open either your existing layout, or a new layout.
· Add a new map in the usual way. It should show your profile. Set the scale and size so that the profile shows as you wish it to. If you want it to match your main map, set both to the same scale.
[bookmark: adding-labels-and-a-grid]Adding labels and a grid
Experiment with the usual map elements to see how you can annotate your profile graph.
· To add labels to the axes and lines on the graph add a grid to the window in the usual way.
· You can set the grid interval in the usual way. For a section setting it to 100 metre intervals may work best, but experiment to see what works best for you.
· You can Draw Coordinates on just the axes that you want to.
· Use the Extents on the Item properties for the map to control the lengths of the axes. For example, you can set Y min to 0 to set the scale to start at sea-level.
· Use the Add labels button to add a title and axis labels.
· Don’t forget to Lock layers on the Item Properties to prevent the profile from being changed when you move to other layers.
[image: images/three_d/WashburnProfileLayout_small.png]
A map and profile created within a layout in QGIS. Note that if you set up the profile this way it is simple to set the map and profile to the same scale.
[bookmark: viewing-3d-topography-in-qgis][bookmark: _Toc165644560]Viewing 3D topography in QGIS
Sometimes being able to view your data in relation to the land surface can really help you to interpret it. QGIS has a plugin which is an effective and simple way of allowing you to do this.
Recently QGIS has gained an inbuilt 3D Map viewer. It is being actively developed at the moment and the version in 3.18 of QGIS has more functionality than the version in 3.16, but for now the plugin I show you below is more reliable. The inbuilt 3D viewer is worth keeping an eye on in future, though.
If you want to try the inbuilt 3D Map Viewer there is more information in the QGIS Desktop User Guide.
QGIS has a plugin which gives more options for viewing your data in 3D, including extruding vector layers and exporting a view as a web page. It is worth installing this and trying it out and that’s the version I’m going to show you now.
[bookmark: installing-the-qgis2threejs-plugin]Installing the Qgis2threejs plugin
You can install the Qgis2threejs plugin in the same way you’ve used for other plugins.
· Open the plugin manager by going to Plugins > Manage and install plugins
· Go to the Not installed tab and search for Qgis2threejs then install the plugin
[image: images/three_d/InstallQgis2threejsPlugin_small.png]
Installing the Qgis2threejs plugin.
[bookmark: creating-a-3d-view]Creating a 3D view
[image: images/svg/warning-black-24dp.png] Warning
Note that if you have already run the QGIS internal 3D viewer you will need to close it, then close QGIS completely and reopen your project before you run the Qgis2threejs plugin.
To open the plugin
· Either click on the new button on the toolbar (a triangle symbol)
[image: images/three_d/Qgis2threejsButton_small.png]
The Qgis2threejs button on the toolbar.
· Or go to Web > Qgis2threejs > Qgis2threejs Exporter on the menu bar.
[image: images/svg/videocam-black-24dp.png] Viewing a map in 3D with the Qgis2threejs plugin.
This video clip can be found in the module area of Minerva or in the full list of video clips.
The window that opens will have a blank main window and a list of your layers on the left.
· Under the DEM heading in the layers on the left click to put a tick next the to T5merged layer.
Your map should appear and should already be shown as a 3D view with any layers that you have visible on your main map, visible on this one too.
[image: images/three_d/Qgis2threejsExporter_small.png]
The Qgis2threejs exporter showing the ticked DEM layer on the left and the map in a 3D view on the right.
· Use your mouse to navigate in the scene. The mouse wheel will let you zoom in and out. If you click on the map you get a pop-up menu with the coordinates at that point and an option to zoom in to that point or orbit around it (press Esc to stop orbiting!). Just have a go…
· You can also use the navigation tool at the bottom right of the 3D map view - if it isn’t visible go to View > Widgets > Navigation widget and put a tick in the box next to it. It’s a bit limited but try cilcking on one of the dots to see what happens.
[image: images/three_d/NavigationWidget_small.png]
The navigation widget showing the orientation of the main axes.
· Press F5 (reset) to get back to the original view.
· To change the vertical exaggeration go to Scene > Scene settings.... Set the Vertical exaggeration to 3.0 and click Apply to see what happens. Use this setting with care - for a scientific map it’s usually best to stay at 1.0 vertical exaggeration which is the same as the real world.
[bookmark: the-dem-settings]The DEM settings
There are other settings that you can experiment with.
· Right-click on the DEM layer (T5merged) in the left-hand panel.
· Click on Properties
[image: images/three_d/Qgis2threejsDEMProperties_small.png]
The DEM Properties panel showing the alterations you can make to the output quality.
Some of the settings here control the quality of the output image.
· Raising the Resampling level increases how much of the data from the original DEM QGIS uses to render the 3D effect. Raise with care - the higher the setting the longer it will take the 3D view to draw.
· If you zoom into the 3D map the map that is being displayed may not look particularly good quality. To increase the quality you can increase the setting for the Texture width (px).
· Try typing 2048 into the box, click Apply and have another look at the map view.
· Again be careful how high you set this - higher numbers will make the 3D view take longer to draw. The quality will also be limited by the quality of the original image.
[image: images/svg/create-black-24dp.png] Drape the aerial photography on the 3D view
Close the 3D window to go back to your main map and turn on the group called Aerial in the Layers panel.
Now reopen Qgis2threejs.
Again, have a look around the 3D map. Aerial photographs can look very effective viewed in 3D, though there can be odd effects when, for example, buildings are flat. We’ll do something about this soon!
[bookmark: exporting-an-image]Exporting an image
Once you have a view that shows your data in a way that will enhance the interpretation, you can export it as an image. The image can then be included in reports and map layouts.
From within the Qgis2threejs window:
· File > Save scene as... > Image (.png)
· You can change the output size here if you wish, then click on Save
· Browse to where you wish to save the image and give it a name, then click on Save.
[image: images/three_d/Qgis2threejsExportImage_small.png]
A view of Otley Chevin exported as an image from Qgis2threejs.
[bookmark: Xcd644b11abdafee66e6556d7fac24f886bf4b9f]Saving a 3D map as an interactive web page
One of the fun things about Qgis2threejs is that you can export the 3D map in a way that can be interactively viewed by anyone with an up to date web browser. In fact, this was the original main point of this plugin.
· Go to File > Export to Web...
· Next to Output Directory click on Browse... to browse to the folder where you want to save the web output. I’d suggest you make a new folder within the project folder and call it something like Output.
· Leave the HTML Filename as index.html
· If you wish, enter a Page Title which briefly says what your map shows.
· Tick next to Enable the Viewer to Run Locally
· Then click on Export
[image: images/three_d/ExportToWeb_small.png]
The Export to Web settings.
Once you’ve done this a set of new files will appear in the folder that you selected, and you’ll see the Log which gives you a list of directories as links.
[image: images/three_d/ExportToWebLog_small.png]
The Log for Export to Web showing the output folders as clickable links.
Depending on your default web browser, you should be able to click on the link next to Web page file to open a view which looks very like the one you have in QGIS.
You can also double-click on the index.html file in the folder.
You can share this with people who don’t have GIS by giving them the whole folder of files and telling them to click on index.html. Do be aware that the data included in these is still liable to copyright, though. In particular data from Digimap shouldn’t be shared with anyone who isn’t a member of UK Higher Education and signed up to the Digimap terms and conditions.
[bookmark: extruding-vector-layers]Extruding vector layers
So far we’re just showing the map canvas in 3D laid on top of a terrain layer. It is also possible to “extrude” vector layers in the 3D viewer. A popular use for this is to extrude building polygons, but you can also use this as a way to display your data. We’ll look at a couple of examples here. Firstly showing a 3D view of crime data for this area, then to show building height.
[bookmark: extruding-numerical-point-data]Extruding numerical point data
These instructions will also work for lines and polygons.
[image: images/svg/videocam-black-24dp.png] Extruding data in a 3D view in the Qgis2threejs plugin.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Close the Qgis2threejs Exporter to go back to your main map.
· In the main map turn off the Aerial layer so that the 25k raster is visible again.
· Make the Crime Stats group visible.
This shows similar data to that used in the vector data analysis chapter, but for Otley rather than Leeds. The data has been processed to show number of crimes per head of population for January 2021 according to Lower Super Output Areas (LSOAs). You should be able to see the red dots which are the centre of each LSOA with the crime figures as the label.
· Reopen the Qgis2threejs plugin. The view should look similar to your main map.
· Tick the box next to Crimes per head of population in the left-hand panel
· Then right-click on the layer to go to the Properties
· Fill in the properties as follows:
· Set the Object type to Cylinder - you can experiment if you wish, but this seems to be the best option for this data.
· The Z coordinate mode should be set to Relative to "T5merged" layer - otherwise the extruded shapes would either be floating above the ground or partially buried.
· Altitude should remain as 0
· Change Radius to 30
· The Height is the key property - click on the E button at the end of the line and use the Expression editor to enter round("Crimes_per_pop" * 10000, 2). The numbers involved are very small, so multiplying by 10,000 means that the differences become visible when extruded in map units.
· To label in 3D click next to Export attributes then set the Label field to Crimes_per_pop and Label height to Relative.
· Click on Apply and have a look at your scene. At this stage you can make any changes you wish so that the differences in your data are clear.
[image: images/three_d/CrimeExtrusion_small.png]
Filling in the layer properties to extrude the crime data.
The end result should show the points in the LSOAs with the higher crime rates as taller symbols. Have a look at your scene from various angles and note how the labels, which have “leader lines” attaching them to the symbols, move so that they are always facing the viewer.
[image: images/three_d/CrimeExtrusionScene_small.png]
The extruded crime symbols showing the differing heights and the labels.
The point styles and label styles reflect those in your main map, so you can change those if you wish to change how t in your main maphe 3D symbols look.
[image: images/svg/create-black-24dp.png] Changing the point style
Try changing the style of the points to Graduated > colour in your main map and look at how that appears in the 3D view.
If you think this helps with the interpretation of the data then keep it like this.
[bookmark: extruding-building-data]Extruding building data
At the moment the buildings are flat on the terrain, whether shown as the 25k raster background map or the aerial photographs. If you have building height attributes in a feature class you can also extrude the buildings to give an impression of the urban environment.
The Buildings layer that I have provided in the project is taken from the Ordnance Survey MasterMap Topography Layer - Building Height attribute data. Details of how to use the data for your own areas is available in the pdf linked from that link.
· In your main map make the Buildings layer visible. So far this is just showing the footprint of each surveyed building. This doesn’t have to be visible for you to extrude the data as the 3D settings are separate.
· Open the attribute table of the Buildings layer and have a look at the columns.
In particular have a look at the numerical attributes towards the right-hand side. Some start Abs... for absolute - these are building heights above sea-level. As we have the DTM in our project it makes more sense to use one of the heights which starts Rel... for relative, i.e. to the height of the terrain at that point.
We’ll use the RelHMax attribute to extrude the buildings on our map.
· Close the attribute table and open the 3D view again.
· Put a tick in the box next to Buildings in the Layers panel and untick the crime data.
· Right-click on Buildings and go to Properties
Filling in the properties dialog is very similar to what we did with the crime data, but this time do the following:
· Set Object type to Extruded
· The Mode is Relative to "T5merged" layer
· Height should be set to Expression then drop down the box underneath and select the height field - RelHMax. Note that this has to be a numerical field.
· Next to Edge color select Feature style
· Click on OK to view the 3D buildings.
[image: images/three_d/ExtrudingBuildingsSettings_small.png]
Settings for extruding buildings.
If you zoom in on your map you should be able to see that the buildings have been styled as 3D “boxes” according to the maximum heights.
Note that it can take QGIS quite a while to draw all the buildings, so be patient.
You can change the fill and outline colours in the main map to change how the buildings look in the 3D view. The buildings do look rather odd in close-up because of the lack of features such as doors and windows!
[image: images/three_d/ExtrudedBuildings_small.png]
The extruded buildings.
Otley doesn’t have any particularly tall buildings, but if you have the building height data for a city such as London you can really see the scale of the skyscrapers.
[bookmark: final-output-for-this-chapter-1][bookmark: _Toc165644561]Final output for this chapter
The output for this chapter can be a series of profiles and three dimensional views of Otley and Otley Chevin.
Try creating a layout in QGIS which includes the “flat” map, a profile from north to south across the hill just to the south of Otley. This is Otley Chevin. Don’t forget to include a line on the map showing where the profile refers to. You can also include separate three dimensional views of Otley Chevin, the crime figures, and the extruded buildings.
You’ll need to export the profile and the 3D views as images to include them in your layout.
Export your layout as pdf or an image file.
[image: images/three_d/FinalLayout_small.png]
Example of final layout for this chapter. You can also output individual images or profiles.
[bookmark: X9a46a3826ddaad8cc224728b3c4a0643576cedd][bookmark: _Toc165644562]Recommended reading: Elevation and 3D mapping
The general books in the module reading list[footnoteRef:7] include sections on elevation and 3D mapping. [7:  Reading list available from Minerva and from the module catalogue.] 

· For a quick overview look at Darkes (2017) - pages 46-47 look at Relief.
· Heywood (2011) has a section on Modelling the Third Dimension on pages 99-100.
· Longley (2015) covers User Interation and Representation in 2.5-D and 3-D on pages 282-284.
[bookmark: further-information-1]Further information
· For a video on the qProf plugin see Topographic Profile Graphs with qProf in QGIS on YouTube.
· If you want to find out more about Qgis2threejs see the tutorial by Alasdair Rae.
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